
More - HSB and RGB dialog boxes

HSB
The More - HSB dialog box displays the Hue, Saturation, Brightness (HSB) color model. This model is the closest 
approximation to how we perceive color. Hue determines color, saturation determines color depth, and 
brightness determines the percentage of white used to make the color lighter or darker.
To adjust the color, drag one or both of the visual selectors:
· The circular selector adjusts the hue.
· The triangular selector simultaneously adjusts saturation and brightness.

RGB
The More - RGB dialog box displays the Red, Green, Blue (RGB) color model. It is based on the light primary 
colors, and is appropriate for images that are displayed on a computer monitor or on transparent media such as 
slides.
To adjust the color, drag the sliders or type values in the R, G, and B boxes.



Position dialog box
The Position dialog box displays the position of your object, measured from the upper left corner of the page.

Horizontal
Specifies the distance of your object from the top of the page.

Vertical
Specifies the distance of your object from the left side of the page.

Leave Original
Creates a duplicate of your object at the new position you specify.



Size dialog box
The Size dialog box displays the size of your object.

Horizontal
Specifies the width of your object.

Vertical
Specifies the height of your object.

Leave Original
Creates a duplicate of your object with the new dimensions you specify.



Fade dialog box
The Fade dialog box displays the fading of your object’s color as percentage. A value of 100 fades your object to 
the point that it is no longer visible. A value of -100 darkens your object so that it is entirely black. Move the 
slider to the right to increase fading.



Corner Roundness dialog box
The Corner Roundness dialog box displays the roundness of the corners of your rectangle. Move the slider toward
Round to smooth the corners into curves.



Ellipse/Pie/Arc Control dialog box
The Ellipse/Pie/Arc Control dialog box displays the characteristics of your ellipse.

Style

 Changes your pie wedge or arc to an ellipse

 Changes your ellipse to a pie wedge

 Changes your ellipse an arc

Start
Specifies the angle at which the pie or arc begins.

End
Specifies the angle at which the pie or arc ends.

 Creates a clockwise arc or pie wedge.

 Creates a counterclockwise arc or pie wedge.



Polygon dialog box
The Polygon dialog box displays the number of sides for your polygon. To change the number of sides, type a 
value in the Number Of Sides box.



Resize Rows/Columns
The Resize Rows/Columns dialog box displays the size of the cells in your table.

Cell Width
Specifies the width of the cells.

Cell Height
Specifies the height of the cells.



Number of Rows/Columns dialog box
The Number of Rows/Columns dialog box displays the number of rows and columns in your table.

Number Of Rows
Specifies the number of rows in the table.

Number Of Columns
Specifies the number of columns in the table.



Insert Rows/Columns dialog box
The Insert Rows/Columns dialog box allows you to insert additional rows and columns into an existing table.

Rows
Inserts rows into the table.

Columns
Inserts columns into the table.

# Of Rows/Columns
Specifies the number of rows or columns to insert.

Before Selected Cells
Inserts the rows or columns before the selected cells.

After Selected Cells
Inserts the rows or columns after the selected cells.



Delete dialog box
The Delete Rows/Columns dialog box allows you to delete rows and columns from an existing table.

Row
Deletes the selected row from the table.

Column
Deletes the selected column from the table.



Backdrop import dialog box
The Backdrop Import dialog box sets the position of the backdrop. Drag the image in the Preview window to the 
desired location.

Fit To Page
Fits the backdrop to the size of your page.



Page Setup dialog box
The Page Setup dialog box sets the orientation (landscape or portrait) and size of your project.

Portrait
Creates a page that is longer than it is wide.

Landscape
Creates a page that is wider than it is long.

Width
Specifies the width of the page.

Height
Specifies the height of the page.

Note
· You can change the unit of measure in the Options dialog box in the Tool menu.



Page Colors dialog box
The Page Colors dialog box allows you to change the background colors of the Notebook and desktop. Click a 
color button to choose a new color for either area.



Keep dialog box
The Keep dialog box allows you to name a coloring, line, or shadow style before adding it to the Styles page of 
the Notebook.
Type a name in the box. When you want to use the style, go the appropriate Styles page of the Notebook and 
scroll through the styles to find the name.



Print & Photo House CD Not Found dialog box
The Print & Photo House CD Not Found dialog box alerts you that you need the Corel Print & Photo House CD-
ROM in your CD-ROM drive to perform your current task. Tasks that require the Corel Print & Photo House CD-
ROM include:
· using the QuickWay or Start With A Sample options in the Create Wizard
· opening the Clipart, Backdrops, Borders, Phrases, or Photos pages of the Notebook
To continue, insert the CD-ROM and click Retry.



Align & Distribute dialog box
The Align & Distribute dialog box aligns and distributes selected objects horizontally and vertically. You can align 
objects by their left, right, top, or bottom edges, or by their center points. You can also distribute selected 
objects horizontally and vertically across the page or across the space occupied by the selected objects.
Use the following buttons to choose your alignment and distribution options:

 Distributes the selected objects horizontally.

 Aligns the top edge of the selected objects horizontally.

 Aligns the center of the selected objects horizontally.

 Aligns the bottom edge of the selected objects horizontally.

 Distributes the selected objects vertically.

 Aligns the left edge of the selected objects vertically.

 Aligns the center of the selected objects vertically.

 Aligns the right edge of the selected objects vertically.

Align/Distribute To Page
Distributes the objects evenly over the page.

Align/Distribute To Selection
Distributes the objects over the area occupied by the selected objects.
The Preview window in the dialog box shows the general effect of each alignment and distribution option (or 
combination of options), but is not meant to accurately reflect the size or exact location of your objects.



Fit Text to Path dialog box
The Fit Text to Path dialog box allows you to specify how the selected text is placed in relation to the selected 
graphic object or line.

Orientation

 Rotates each character to follow the contour of the line or object.

 Centers the base of each character on the line or object.

Vertical Alignment

 Aligns the text baseline with the line or object.

 Aligns the text ascender with the line or object.

 Centers the text on the line or object.

Side

 Specifies which side of the object the text is placed on: top, right, bottom, or left.

Horizontal Offset
Specifies how far along the line or object you want to position the text.

Distance From Path
Specifies how far above or below the path you want to place the text. Use positive values to place the text above
the path or object, negative values to place the text below the path or object.

Place Text On Inside
Flips the text to the opposite side of the path and reverses the path’s start and end points.



Save As dialog box
The Save As dialog box allows you to save your project on your hard drive or floppy disk. The list box in the 
middle of the dialog box shows the folders and files in the selected location. You can double-click a folder to open
it.

File Name
Provides a space for you to type the name of the file. You can also type the full path of a file. For example, you 
can type c:\mydocs\letter.doc.

Save As Type
Specifies the type of file you are saving. The list includes all the available file types that Corel Print House can 
export to.



Import File dialog box
The Import File dialog box allows you to import files for use in Corel Print House. The list box in the middle of the 
dialog box shows the folders and files in the selected location. You can double-click a folder or file in that box to 
open it.

File Name
Provides a space for you to type the name of the file. You can also type the full path of a file. For example, you 
can type c:\mydocs\letter.doc. If you want to search for a file you can type *.* in the File Name box to see a list of
all the files.

Files Of Type
Specifies the type of file you want to import. The list includes all the available file types that Corel Print House 
can import.
You can import entire files by selecting Full Image, or crop or resample areas of an image by selecting those 
options from the list box.



Options dialog box
The Options dialog box contains the settings which affect how Corel Print House displays objects on the screen 
and how it performs certain operations. Think of this dialog box as a filing cabinet. Its contents are separated 
into two files: General and Edit. To open a file, click its tab.

General options Description
Page Size Controls the default paper size
Page Units Specifies the default unit of measure used in dialog boxes
Colors Controls the colors of the Notebook and desktop. Click the buttons to 

change the color.
Undo Levels Determines the number of actions or operations that can be reversed 

using the Undo command in the Edit Menu. As you increase the 
number of undo levels, you increase the amount of memory required to
run Corel Print House.

Monday First Day Of 
Week

Controls the day used by the Calendar Wizard. If the option is disabled,
Sunday is used as the first day of the week.

Use Wizard At Start Up Controls whether the Create wizard appears each time you launch 
Corel Print House. If the option is disabled, the wizard does not appear 
and the Show Welcome Page option is automatically disabled.

Show Welcome Page Controls whether the Welcome wizard appears each time you launch 
Corel Print House. If the option is disabled the wizard does not appear.

Print Instructions Sheets 
For Manual Duplexing 
Print Jobs

Controls whether instruction sheets are printed each time you use the 
Manual Double-Sided Printing Wizard. If the option is disabled, the 
instructions are not printed.

Edit options Description
Place Duplicates Controls the amount of horizontal and vertical offset from the original 

when objects are duplicated with the Duplicate command. Positive 
Horizontal values shift the duplicate to the right, while negative values 
shift it to the left. Positive Vertical values shift the duplicate up, while 
negative values shift it down. 

Nudge Controls how far a selected object moves when you press the direction 
keys on the numeric keypad.

Constrain Controls the angle of motion when you skew or rotate an object while 
holding down CTRL, or when you draw straight lines in Freehand mode 
holding down CTRL. 

Corner Threshold Controls the appearance of corner joints. Corners that are less than the 
miter limit have a beveled point. Corner joints greater than the limit 
come to a sharp point. This limit prevents corners that extend far beyond 
the actual corner at small angles, like when a text character comes to a 
spike, as in the letter M.

Auto Close Specifies how close together the ends of a line segment need to be 
before they are automatically closed

Smoothness Controls the smoothness of freehand curves. The higher the specified 
number, the smoother the curve will be. 

Image dialog boxes

Crop Image dialog box
The Crop Image dialog box allows you to crop an image before importing it. The cropping is permanent and 
creates a new, smaller image.
The image is displayed with a bounding box around it. Move the handles on the bounding box to crop the image. 
Use the Hand cursor to move the bounding box to a specific area of the image.
You can also specify the area you would like to crop in the Select area to crop options. The values in the Width 
and Height boxes reflect the measurement unit that is selected in the Units list box. To choose a different 
measurement unit, click the down arrow.



The Select All button selects the entire image by resizing the bounding box to cover the entire area.

Resample Image dialog box
The Resample dialog box allows you to change the resolution of an image before importing it.
Select the Height and Width of the resampled image. The values in the Width and Height boxes reflect the 
measurement unit that is selected in the Units list box. To choose a different measurement unit, click the down 
arrow. The size of the resample image can be set in proportional size to the original image by adjusting the 
values in the Percentage boxes.
Enable the Maintain Aspect Ratio option to maintain the image width and height proportions. 
The Resolution boxes control the resolution of the image currently being resampled. Resolution refers to the 
fineness of image detail and the amount of information required to record, store, display, and print an image. 
Resolution is measured in dots per inch (dpi), referring to the number of pixels used to construct an image. 
Choose a resolution that your printer is capable of printing. 



Namelist Import dialog box
The Namelist Import dialog box allows you to import Tab Separated data (in a .TXT format) into a Corel Print 
House Namelist. The list box in the middle of the dialog box shows the folders and files in the selected location. 
You can double-click a folder in that box to open it.

File Name
Provides a space for you to type the name of the file. You can also type the full path of a file. For example, you 
can type c:\mydocs\address.txt.

Note
· Any Tab Separated data that has been saved as ASCII text (text only) can be imported using the Namelist 

wizard. Text can be imported from word processors such as Corel WordPerfect, or spreadsheets such as Corel 
Quattro Pro. Below is an example of data in the Tab Separated format:

Name Address City Prov/State Country
Sarah 16 Ventura Blvd. Ottawa ON Canada
Shane 6 Draw Lane Toronto ON Canada
Dave 2 Flow Rd. Orem UT USA
Tasha 55 Gallery Ave. Orem UT USA
Mark 95 Xara St. Dublin Ireland
Sandra 12 Presents Ct. Dublin Ireland



Bitmap Export dialog box
The Bitmap Export dialog box allows you to specify how you want to export bitmap files.

Color
Displays a list box of color modes. The greater the number of colors, the larger the file.
· black and white = 1 bit
· 256 shades of gray = 8 bits
· 16 colors = 4 bits
· 256 colors = 8 bits
· 16 million colors = 24 bits
· CMYK image = 32 bits
Not all levels of color or grayscale are supported by all bitmap formats. If you have chosen a bitmap format that 
does not support a gray or color format, the option will not appear in the list box.

Dithered
Dithers the colors and gray shades in the exported file. Dithering may produce better results when exporting 
fewer colors than the original image. If the image contains fountain fills or color blends, dithering can cause 
obvious banding. Here are some guidelines to help you decide whether to dither the bitmap:
· If you are exporting 16 or 256 colors or grays, use dithering.
· If you intend to scale the bitmap in another application, dithering is not recommended.

Size
Specifies the dimensions of the exported bitmap. If a size is not selected, the original image is used.

Height
Controls the height of the file in pixels.

Width
Controls the width of the file in pixels.

Resolution
Specifies the resolution (in dots per inch) for bitmaps.

Horizontal
Displays the horizontal resolution of the image. Resolution refers to the fineness of image detail and the amount 
of information required to record, store, display and print an image. Resolution is measured in dots per inch (dpi),
referring to the number of pixels used to construct an image. Choose a resolution in keeping with the resolution 
of your monitor and printer. If you plan to print an image, choose a resolution close to the maximum dpi output 
value of your printer, otherwise you may not be able to print much of what you see on screen. If you do not plan 
to print an image, you can choose a higher resolution to maximize image detail.

Vertical
Displays the vertical resolution of the image.

Identical Values
Maintains equal horizontal and vertical resolution values. Any value entered in one box will cause the other box 
to change automatically.

Anti-aliasing
Anti-aliasing creates a smooth bitmap by removing jagged edges. Ensure that you have sufficient memory 
available (relative to the system you are using) before choosing this option and clicking OK.

Projected uncompressed file size
Shows the estimated size of the exported file before compression. Compressed files will be smaller than the 
value displayed.



Reset button
Returns to the settings in effect when you opened the dialog box.

Notes
· High resolutions require large amounts of disk space.
· As resolution increases, so does the time required to print the image.



.WPG Export dialog box
The .WPG Export dialog box allows you to specify how you want to export .WPG files.
.WPG (WordPerfect Graphic) is a vector file format developed by WordPerfect Corporation. It is used to store 
document and image data. WPG is supported by MS-DOS, Windows, Macintosh and UNIX platforms, and by Corel 
WordPerfect and other word processing applications. WPG supports 256 colors and RLE compression.

16 Colors
Saves the image using a 16-color palette. Choose this option if you will be editing the image on a 16-color 
monitor.

256 Colors
Saves the image using a 256-color palette.

Text
Saves text as editable text characters.

Curves
Saves text as curves. Choose this option if you don’t need to edit the text, or if you aren’t sure which fonts are 
available on the other systems or output devices that you will be using with this file.



.WMF Export dialog box
The .WMF dialog box allows you to specify how you want to export .WMF files.
WMF (Microsoft Windows Metafile) is a vector file format developed by Microsoft Corporation. It is supported by 
Windows and several Windows-based graphics applications. WMF supports 24-bit color, and is widely used to 
store and exchange vector and bitmap data between Windows-based applications.

Text
Saves text as editable text characters.

Curves
Saves text as curves. Choose this option if you don’t need to edit the text, or if you aren’t sure which fonts are 
available on the other systems or output devices that you will be using with this file.

Includes Placeable Header
Includes a header with the file that specifies the dimensions of the image. It is recommended that you choose 
this option unless you know that the application you will use to edit the image doesn’t recognize placeable 
headers.



Photo CD dialog box
The Photo CD dialog box lets you specify image size and color mode. Color mode affects the size of the file, the 
system’s memory, and the quality of the printed image. It is important to choose a color mode that meets your 
end requirements. Use the following guidelines when you are choosing a color mode:
· Choose 256 grayscale to create duotones and to print to a black and white laser printer.
· Choose 256 colors (8-bit) to create non-photographic images and to print to a low-end color printer
· Choose 256 colors (8-bit) if your system has low memory.
· Choose 24-bit color to create high-quality photographic color images and to print to an RGB or CMY printer.

{button ,AL(`photo cd;',0,"Defaultoverview",)} Related Topics



Photo CD Image Enhancement dialog box
The Photo CD Image Enhancement dialog box lets you apply color correction to a Photo CD-ROM image before 
importing it into Corel Print House. There are two color correction methods: GamutCD and Kodak. 
· GamutCD

Uses gamut mapping to enhance the color fidelity and tonal ranges of the image, which ensures that the 
colors in a computer image can be reproduced by a printer.

· Kodak
Lets you alter color tints, adjust brightness and color saturation, and adjust the contrast.

{button ,AL(`photo cd;;;;;',0,"Defaultoverview",)} Related Topics
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Backdrop
A backdrop is a graphic that is placed behind the other objects in your project, like the background of a painting. 



Border
A border is a pattern that you can place around the edge of a page.



 Catalog
The Catalog page in the Notebook contains collections of clipart, backdrops, borders, and phrases. To add any of 
these items to your project, drag them from the Notebook and drop them onto the appropriate part of your 
design.



Clipart 
Clipart is ready-made art that you can add to a project. (You can also change clipart to fit your specific needs.).



Clipping hole
A transparent hole through which underlying objects are visible. Also referred to as a mask or clipping mask.



Coloring Book
Coloring Book view displays your drawings in outline form. In other words, when you view your drawings in 
Coloring Book, you don’t see any fills or outline attributes. Using this mode allows for quick redrawing times. You 
can also print your work using the Coloring Book option.



Combine
Combining objects places shapes inside one another and then extrudes them. The result is that the inner shape 
"cuts" holes in the larger shapes. A donut is an example of the kind of object that can be created by combining 
shapes.



Curve object
An object with nodes and control points that you can manipulate to change the object's shape. Curve objects are
drawn with the Freehand tool. You can also convert text and objects drawn with the Rectangle and Ellipse tools 
into curve objects using the Convert To Curves command in the Arrange menu.



 Desktop
The desktop is what you see on your screen when you are using Corel Print House. 
When you start Corel Print House for the first time, the Standard Toolbar and Text Toolbar are hidden. To view 
them, click the View menu, and then click the Standard Toolbar and Text Toolbar commands. A check mark next 
to the commands indicates that the toolbars will display on your screen.



Effect
An effect is a method of embellishing objects in Print House. For example, a drop shadow is an effect you can 
add to an object to make it standout. 

Example



 Ellipse
An ellipse is an oval or a circle.

Examples



End node 
The end node is the last node in a path. It is the small square at the end of an open path that appears when you 
select the path with the Shaper tool. The end node is smaller than the start node.



Fill
A fill is the color or coloring inside an object. An object can have a solid fill (a single color), a gradient fill (a blend
of two colors), or no fill. (You can change the fill of an object at any time.) 
No Fill

 
Solid Fill



 Font
A font is a set of characters which usually includes the alphabet and several other symbols. Each font has 
different characteristics that change its appearance. Print House comes with more than a hundred fonts, and the 
font you choose for your text can completely change the mood of your message.

Examples



Freehand shape 
A freehand shape is a shape that you create by dragging the mouse pointer over the drawing area like a pencil 
on paper. Freehand shapes can be straight lines, curves, or any shape.

Examples



Group
A group is a number of objects that behave as one object. You create a group by selecting several objects and 
grouping them. Clipart may also contain groups.
Groups can be filled with color and outlined. If you change the group’s color and outline, all of the objects in the 
group will have the same properties. For example, if you group a blue ellipse and a red rectangle and you select 
a yellow fill color, both objects will become yellow. 



Home node
The home node (or start node) is the first node in a path. It is the square at the end of an open path that appears
when you select the path with the Shaper tool. The home node is larger than the end node.



Key Page
The Key page of the Notebook displays help topics to assist you with your current task. The topics shown are 
determined by the tool, menu, or wizard in use. The Key page walks you through tasks using cue cards. Each cue
card contains an instruction. You move through the cards as you complete each step.



 Marquee-select 
A method of selecting multiple objects with the Pick tool, or multiple nodes with the Shaper tool, by dragging a 
dotted rectangle around them.



Mask 
The combining of two or more objects using the Combine command from the Arrange menu to create a 
transparent hole through which underlying objects are visible. Also referred to as a clipping mask or clipping 
hole.



Namelist
A Namelist is a small database that can store names and addresses for you to merge with your Print House 
projects.



Nested group
A nested group is when two or more groups of objects behave as a single group.



Nib 
The nib is the shape of the brush that creates line styles. Different nibs create different line styles and sizes. 



Node 
Nodes are the single points that define paths. As a path passes through a node, the direction of the path can be 
changed. 



Notebook
The Notebook looks like a spiral-bound notepad that has been placed on your screen. It is located on the left side
of the Corel Print House desktop. The Notebook is made up of three sections, each with different information. To 
go to a specific section, click the corresponding tab.
Use the Notebook to:

 access the catalog of Corel Print House resources such as clipart, borders, backdrops, and phrases 
 get assistance with tasks such as adding graphics, editing text, and saving and printing projects 
 add colors, line styles, text styles, and shadows to your project



 Object
Objects are the building blocks of each project. Everything you place or create on your page is an object. Lines, 
shapes, graphics, and strings of text are all objects. Objects are constructed from paths which determine their 
shape. All objects can have outlines and can be filled with color. 

Examples



Outline
An object's outline defines the appearance of the object's edges. The outline can be different colors and 
thickness. You can also change the line style (e.g., make it dashed), and add arrowheads to the ends of lines and 
curves.



Path 
A path defines the shape of each object. A line, for example, is a path drawn between a start point and an end 
point. A path can be open or closed. An open path is a path with a separate start and end (e.g. a line). A closed 
path's start and end meet (e.g., a circle). 



Phrase
A phrase is a pre-written verse or sentiment that you can add to your cards or to other Print House creations. 
Pre-written phrases can be found in the Catalog section of the Notebook.



Polygon
A polygon is a shape with any number of sides (minimum of three). Polygons can be simple (e.g., a pentagon) or 
star-shaped.

Examples



Print Merge
The Print Merge option allows you to merge data (e.g., names and addresses) stored in the Namelist with your 
Print House projects.



Project
A project is a Print House creation. For example, a card or poster is a project.



Property
A property is a characteristic of an object that you can change. For example, an object's color is a property.



 Property Bar
The Property Bar displays the properties for the text or shape object that is selected. Properties are attributes 
such as coloring, line style, and positioning. From the Property Bar you can change the properties of the selected 
object.
To change an object’s properties, select the object with the Pick tool, and then click the button on the Property 
bar for the attribute you want to change.



Rectangle
A rectangle is a shape with four straight sides. A rectangle can be square.

Examples



Rotating 
Rotating an object turns it around an axis without changing the way the object looks. 



 Sample
A sample is a finished project that you can change to create your own work. 



Scrapbook
The Catalog page in the Notebook includes a section called the Scrapbook. You can use the Scrapbook to save 
pieces of your own creations for later use. For example, if you create a logo, drag it to the scrapbook so that you 
can add it to future projects.



 Segment 
A segment is the portion of a path that lies between two nodes. 



Skewing
Skewing an object slants the object. This action changes the way the object appears. 



Start node 
The start node (or home node) is the first node in a path. It is the square at the end of an open path that appears
when you select the path with the Shaper tool. The start node is larger than the end node.



 Styles Page
The Styles page in the Notebook contains colorings, line styles, and shadows you can use to enhance your 
projects. To apply a style to part of your project, drag the style’s icon from the Notebook onto the item you want 
to change. For example, to apply a specific coloring to a rectangle, drag the coloring icon onto the rectangle and 
release the mouse button. 



Template 
A template is a framework for creating a project. Templates show where to place the elements of your design.



Text object
A text object is a string of text. When you create a text object, the font that you use defines the way the text will 
appear. 
Print House allows you to add Artistic Text and Paragraph Text directly on the page. Use Paragraph text for 
adding large blocks of text to your adds, brochures, and other projects.

Example



 Toolbar (Standard Toolbar)
A toolbar places controls on your screen that allow you to easily access features of the program. The Standard 
Toolbar contains Print, Cut, Copy, Paste, Zoom In, Zoom Out , and Zoom to Page buttons. 
When you start Corel Print House for the first time, the Standard Toolbar is hidden. To view it, click the View 
menu, and then click the Standard Toolbar command. A check mark next to the command indicates that the 
toolbar will display on your screen.



Toolbar (Text Toolbar)
A toolbar places controls on your screen that allow you to easily access features of the program. The Text Toolbar
contains controls to alter your text. You can control the font type, appearance, and justification.
When you start Corel Print House for the first time, the Text Toolbar is hidden. To view it, click the View menu, 
and then click the Text Toolbar command. A check mark next to the command indicates that the toolbar will 
display on your screen.



 Toolbox
The Toolbox contains tools to create and edit designs. The tools include: Pick tool, Shaper tool, Freehand tool, 
Text tool, Rectangle tool, Ellipse tool, Polygon tool, and the Table tool. Once you select a tool, instructions for 
using it appear on the Key page of the Notebook.



Wizard
A wizard is an automated assistant that helps make each task in Print House simple and trouble free. The wizard 
asks you questions and then performs the appropriate actions based on your answers. For example, the outline 
wizard asks you questions about the type of outline you want to apply to an object, and then applies that outline.



Getting started



Welcome to Corel Print House
Thank you for choosing Corel Print House  the perfect tool for creating cards, posters, banners, and more. 
Corel Print House produces professional results quickly and easily at work or at home. It includes dozens of 
ready-to-print samples for everything from greeting cards to business forms, plus an extensive collection of 
fonts, styles, borders, backdrops, photos, and Clipart.

Corel Print House works the way you want it to. You get as much help as you want, and you have as much control as
you need. If you are in a hurry, Corel Print House can help you create your project in only a few minutes. If you want
to create something completely new, Corel Print House provides all the tools, resources, and assistance necessary.

Corel Print House's simple user interface and extensive wizards make it remarkably easy to use. You can produce
impressive designs by making a few simple choices. For example, to make a greeting card, just choose a sample,
select some Clipart, and type your text. Corel Print House even helps you print your card and shows you how to 
fold it properly.
As your experience grows Corel Print House grows with you. It includes powerful tools that let you create original 
graphics, manage text, and edit existing Clipart and backdrops. And at every step Corel Print House is ready to 
help you make the most of your design.

{button ,AL(`Getting started;',0,"Defaultoverview",)} Related Topics



Corel Print House and Windows NT 3.51
If you are using Corel Print House with Windows NT 3.51, you should be aware of a difference in terminology 
between your system and the Corel Print House User's Guide and online Help. Under Windows 95 and Windows 
NT 4.0, directories are called folders. Since Corel Print House was originally developed to run under Windows 95, 
all documentation was written to reflect Windows 95 terminology.
When the word "folder" is used in wizards, the Notebook, the online Help, or in the User's Guide, you can 
substitute the word "directory" and complete the procedure as usual.
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Installing additional fonts
When you install Corel Print House and choose the Typical Install option, 45 True Type fonts are installed. Over 
100 additional fonts are available on the Corel Print & Photo House CD-ROM. You can install these additional 
fonts any time after installing Corel Print House. The installed fonts are accessible to other Windows applications.
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What's new in Corel Print House 2.0
If you're upgrading from a previous version of Corel Print House, new features for version 2.0 are listed below. For
more information about a topic, click its  button.

    Shapes for molding Artistic text, Paragraph text, and photos. You can drag and drop Shapes from the Notebook 
for instant results, or create and save your own shapes.

    Fit Text To Path command, for wrapping Artistic text around graphic objects
    Align And Distribute command, for arranging objects in relation to each other and to the page
    Hundreds of new sample files, fifty new fonts, and five new project types: Recipe Cards, Kid Stuff, Calendars, 

Envelopes, and Menus
    Revised table-editing tools

    New rainbow fills for text and graphic objects

    Revised Namelist features, for easier merging of Namelists with projects

    Support for continuous feed paper for banners and other projects

    Corel Photo House, a new standalone photo-editing and bitmap creation program that you can use 
with Corel Print House or other applications. You can touch up photos, resize them to fit your Corel Print House 
projects, or create your own bitmaps using the painting tools.
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Corel Print House and the World Wide Web
If you'd like to show off your Corel Print House creations on the World Wide Web, you'll need to convert your 
projects to a suitable file format. Corel Print House allows you to choose between two widely used Internet 
formats: .GIF and .JPG. These formats reduce the file size of your project so that your Web page visitors are able 
to download the image quickly and view it in their Internet browsers. Just use the Save As command in the File 
menu to save your project in the format of your choice.

Emailing Corel Print House projects
If you want to send a project in an email message, save it as a .JPG file. Then, attach the file to your email 
message according to the instructions provided with your email software.

Note
· For cards and other double-sided or folded projects, only the picture on the first page of the project is saved 

when you save the project in .GIF or .JPG format.
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We’d love to hear from you!
If you have any comments or suggestions about Corel Print House, you can email them to 
Printhouse@corel.com.
Unfortunately, we won’t be able to respond to your messages individually, but you can check the Corel Print 
House home page for the latest product news, Corel Print House tips and tricks, downloadable sample files, and 
product upgrade information. The Corel Print House home page is at 
http://www.corel.com/product/PRINTHSE.htm.
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Using Corel Print House with Corel Photo House
Although you can use Corel Photo House to edit bitmaps and photos for any Windows application, it's especially 
easy to use Corel Print House and Corel Print House together. You can launch Corel Photo House directly from 
Corel Print House by selecting a bitmap in Corel Print House, and then choosing the Send To Photo House 
command. Corel Photo House automatically launches and opens your bitmap for editing. When you're finished, 
you can close Corel Photo House and your Corel Print House project will automatically be updated.
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Choosing a method to create your project
The Create wizard offers you a variety of ways to create your project. You can launch the Create wizard from the 
Key page of the Notebook, or using the New Project command on the File menu.

Use The QuickWay
The QuickWay is the fastest and easiest way to complete a project in Corel Print House. The QuickWay 
streamlines the design process by walking you through each step of the project, and minimizing the number of 
samples you choose from. Once you type in your personalized message, your project is ready to print. The whole
process takes only a few minutes and is ideal for Corel Print House beginners or for those in a hurry.

Start With A Sample
Starting with a Corel Print House sample lets you enjoy the convenience of wizards, while choosing from a large 
variety of professional graphic designs. Each type of project has several samples based on different themes and 

occasions. The samples provide you with a starting point  the amount of customization is up to 
you. You can start by adding your own text, and progress to adding and editing Clipart, adding shadows, and 
importing your own photographs.

In addition to the regular sample files, Corel Print House offers hundreds of PaperDirect’s templates. Choose one of 
these templates to ensure that your projects will work with PaperDirect’s special papers.

Start From Scratch
Once you’re familiar with Corel Print House, you may want to use the Start From Scratch option. Corel Print 
House provides a blank piece of paper suited for the type of project you choose. Then, it's up to you to 
experiment with the drawing tools and choose the Clipart, photos, and borders that will make your project 
complete. Don't be afraid to try different designs or incorporate elements from sample projects. And, even if you 
start the project from scratch, you can still use the wizards and Notebook to help you create the finishing 
touches. Starting from scratch is a great way to create a completely original design and show off your creative 
style.

Open An Existing Project
Choose this option to access any project you have previously saved. To open a project, type the name of the file 
or choose it from the list box.

Open Your Last Project
Choose this option to access the project you had open the last time you used Corel Print House.
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Starting a new project
You can start a new Corel Print House project in three ways:
· using the Create wizard which appears when you launch Corel Print House
· using the New command on the File menu
· using the New Project command on the File menu
The New command starts a new project of the same type you are currently working on (e.g., if you are working 
on a side quarter-fold card, the New command starts a blank side quarter-fold card). The New Project command 
launches the Create wizard, which allows you to choose from several project creation methods.
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Using Corel Print House's wizards
A wizard helps you perform tasks in Corel Print House. Wizards break large tasks down into small steps and ask 
you to make decisions for each step. You can use wizards for assistance with almost any Corel Print House task 
such as creating and editing projects, adding colors, and printing your work.
The following table lists the Corel Print House wizards and explains how each can help you complete your 
project. 
Name of wizard What it does
Create wizard Helps you begin your project
Calendar wizard Helps you fill in the dates for calendars you create using the QuickWay
Coloring wizard Helps you fill your object with a solid color or blend two colors together to create a

gradient or rainbow fill
Line wizard Helps you customize any line by guiding you through the selection of styles, 

colors, thickness, and more
Shadow wizard Helps you add special shadow effects to your text and graphic objects
Text Style wizard Helps you define characteristics of your text such as font, size, and color
Namelist wizard Helps you create data records to merge with your projects. For example, you can 

create a list of names and addresses to automatically address envelopes.
Open wizard Helps you open your files and projects for use in Corel Print House
Save wizard Helps you save and organize your projects
Print wizard Helps you choose from a variety of options to successfully print your project
Manual Double-sided
Printing wizard Helps you print double-sided projects on a single sheet of paper
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Corel Print House design projects
The projects that you can create using Corel Print House are divided into 12 main categories:
· Cards
· Calendars
· Banners
· Business Forms
· Envelopes
· Kid Stuff
· Labels
· Signs
· Menus
· Certificates
· Recipe Cards
· Miscellaneous
Each category has many different samples to choose from, all of which are shown in the Samples section of the 
Corel Print & Photo House User's Guide. You can also browse through the samples using the Create wizard. Using 
the samples and a little bit of imagination, there are no limits to what you can create.

 Tip

· Don’t be afraid to experiment with different project types  a brochure may make a great 
greeting card, and a greeting card may make a perfect menu. With over 25 project types to choose from, 
you’re certain to find one to meet almost any need.
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Cards
You'll find cards for almost any theme or occasion in Corel Print House. Greeting card, invitation, and postcard 
samples are available in a wide range of designs and sizes. For occasions that aren’t listed, most samples in the 
All Occasion category have neutral designs that are suitable for a variety of uses. Card folding instructions and 
video demonstrations are available in the online Help.
When you design a card from scratch, five layouts are available: side half-fold, top half-fold, side quarter-fold, top
quarter-fold, and postcard. If you choose a postcard or a half-fold card layout, you can use the Manual Double-
Sided Printing wizard to print your project on a single piece of paper, even if you don't have a duplex printer.
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Banners
When you need to say something in a big way, use a Corel Print House banner. The default size for banners is 
20" x 8.5" or 508 mm x 215.9 mm (three sheets of paper), and the default orientation is landscape. Corel Print 
House prints your project in tiles which you can glue, tape, or staple together to form one large banner.
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Signs
You can use signs for a variety of home, school, and business uses. Corel Print House provides sign samples in 
both portrait and landscape orientations. The default size for signs is 8.5" x 11" or A4 paper. If you need a bigger
sign, you can change the page size using the Page Setup command in the File menu. When you choose a bigger 
paper size than your printer can handle, Corel Print House prints your project in tiles which you can glue, tape, or
staple together to form one large sign.
Signs can also make great T-shirt designs and photo album pages. Click the How To button for complete 
instructions on creating these projects.
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Kid Stuff
The Kid Stuff projects are specially designed for Corel Print House’s younger users. The samples include 
stationery items such as letterheads, address cards, envelopes, note cards, and party items such as invitations, 
banners, and place mats. The letterheads and note cards are great for writing thank-you notes and keeping in 
touch with relatives and pen pals. The party samples make it easy for you to create your own personal 
invitations, and then make matching banners for decoration.

 Tip
· Place address cards in the front of school books and binders so that they can be returned to you if you 

misplace them.
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Certificates
Corel Print House makes it easy for you to create certificates for achievement, recognition, or just for fun. 
Samples are available in portrait and landscape orientations, and in formal, casual, and sports-oriented styles. 
Once you create your certificate, you can use the Text tool to customize it with details such as the names of the 
recipient and presenter, the date, and the name of the award. If you need to create a large number of 
certificates, you can use the Corel Print House Namelist feature to merge a list of names with the certificates 
when you print them.

 Tip
· For a professional appearance, print your certificates on heavy card stock or parchment paper.
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Calendars
Corel Print House provides a variety of samples for monthly and yearly calendars. When you create calendars 
using the QuickWay, you can use the Calendar wizard to fill in the dates automatically. The Calendar wizard lets 
you create monthly and yearly calendars for the years 1800-2099. Once you create your calendar, you can use 
the Text tool to fill in activities, appointments, and reminders before printing it. Calendars are not available when 
you start a project from scratch.

Choosing the first day of the week
North American calendars typically use Sunday as the first day of the week, while European calendars typically 
start weeks on a Monday. If you want to change the default setting, you can enable or disable the Monday First 
Day Of The Week option in the Options dialog box. When the option is enabled, all calendars that you create with
the Calendar wizard use Monday as the first day of the week.

{button ,AL(`Print Houses design projects;',0,"Defaultoverview",)} Related Topics



Business forms
Projects available in the Business Forms category include letterheads, business cards, purchase orders, invoices, 
envelopes, memo forms, and fax cover sheets. Whether you want to use these projects for business or personal 
use, you can choose from a variety of professionally designed samples. Each design is available for each type of 
project, so if you need matching letterhead, business cards, envelopes, and invoices, all you need to do is 
choose the same sample number for each project.
Brochures are a special type of business form that you can use to promote businesses, clubs, or associations. 
Many of the professional two-fold and three-fold brochure samples coordinate with the other business forms. 
Three-fold brochures can be folded in either a regular pattern or a Z-pattern, both of which are demonstrated in 
the online Help.
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Envelopes
Corel Print House allows you to design projects to print on standard size envelopes, or to create your own 
envelopes by cutting and folding a sheet of paper. Some samples are the correct sizes for Corel Print House 
quarter-fold cards. When you use the Start From Scratch option, you can choose one of several standard 
envelope sizes. Envelope projects are not available using the QuickWay.
If you need to print several envelopes at once, you may want to use Corel Print House’s Namelist feature, which 
allows you to combine names and addresses from a database with your project.
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Labels
From home preserves to video cassettes, to address labels and nametags, Corel Print House helps you create 
fun, colorful labels. Sample labels are available in a variety of sizes and styles. If you use the Start From Scratch 
option in the Create wizard, you can choose from layouts that correspond to several popular brands of adhesive 
label sheets. Labels are not available using the QuickWay.
When designing and printing address labels, nametags, or any other project that requires customized text for 
each copy, you may find it helpful to use Corel Print House's Namelist features. They allow you to combine a 
Corel Print House Namelist with your project at the time of printing, so that each copy of the project is 
customized with information from the Namelist.

{button ,AL(`Print Houses design projects;',0,"Defaultoverview",)} Related Topics



Menus
Whether they’re for a restaurant, a fund-raising dinner, or a special dinner party, professional menus are easy to 
design with Corel Print House. Most menu samples are available in two sizes: full-size and table-topper.
A limited number of full-size samples are designed to be folded into three sections. To help you maximize your 
design options, three-fold menus can be folded in either a regular pattern or a Z-pattern. Both folding methods 
are demonstrated in the online Help.

 Tips
· Corel Print House menus are a great way to advertise daily specials.
· For seasonal menus, use colored text, Clipart, and photos to help create a theme.

{button ,AL(`Print Houses design projects;',0,"Defaultoverview",)} Related Topics



Recipe Cards
Recipe Card projects are a fun way to organize your own recipe collection, and give your favorite recipes to 
others. Sample projects can be printed on standard recipe cards or regular paper. If you print the cards on 
regular paper, you can use the Multiples On Page option in the Print dialog box to print several cards on one 
piece of paper. Using the QuickWay, recipe cards are available through the Miscellaneous category.
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Miscellaneous
Projects available in the Miscellaneous category include membership cards, coupons, tickets, office stationery, 
bookmarks, and doorknob hangers. Since the default size for these projects is smaller than a regular sheet of 
paper, you can use Corel Print House's Multiples On Page option to print several copies of a project on one page. 
The Multiples On Page option is not available for double-sided projects such as bookmarks or doorknob hangers.
The office stationery samples include planners, to-do lists, message forms, and memo sheets. Their informal 
style makes them ideal for short notes and messages between coworkers or family members.
When designing and printing membership cards or any other project that requires customized text for each copy,
you may find it helpful to use Corel Print House's Namelist feature. It allows you to combine a Corel Print House 
Namelist with your project at the time of printing so that each copy of the project is customized with information 
from the Namelist.
Doorknob hangers print with a dotted line indicating where you should cut them, so that they fit around a 
doorknob. All sample designs and blank layouts are double-sided, so you can place different messages on each 
side if necessary. If you do not have a duplex printer, you can use Corel Print House's Manual Double-Sided 
Printing wizard to print your design on both sides of the page.
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The desktop
The desktop is what you see on your screen when you use Corel Print House. The first time you start Corel Print 
House, the Standard toolbar and Text toolbar shown in the picture below are hidden. To view them, click the View
menu, and then click the Standard Toolbar and Text Toolbar commands. A check mark next to the commands 
indicates that the toolbars will display on your screen.

Changing the desktop colors
You can change the background colors for the Notebook and the Desktop colors by
· using the Options command on the Tools menu
· right-clicking anywhere on your Corel Print House desktop and choosing Page Colors from the menu
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The Toolbox

The Toolbox holds all the tools you need to create and edit designs. The tools are easy to use  just 
click a tool to select it. Once you select a tool, instructions for using it appear on the Key page of the Notebook.

Key tool 
The Key tool opens the Key page of the Notebook. Click the Key tool when you need help with any task, and 
instructions appear on the Key page.

Pick tool 
The Pick tool selects, moves, and changes the size of objects. Click the Pick tool and then click an object (any 
graphic object, Clipart, or text) in your design to select it. Once you select an object, you can change its 
properties (e.g., color, outline).

Shaper tool 
The Shaper tool changes the shape of lines, graphic objects, or shapes.

Text tool 
The Text tool creates text. Use the Text tool when you want to add text to your design.

Freehand tool 
The Freehand tool draws lines. It is similar to using a pencil on a piece of paper. You can draw a line in any shape.

Rectangle tool 
The Rectangle tool creates rectangles and squares.

Ellipse tool 
The Ellipse tool creates ovals, ellipses, and circles.

Polygon tool 
The Polygon tool creates graphic objects with three or more sides. Use the Polygon tool to create triangles, stars,
or other polygons.

Table tool 
The Table tool creates an empty table in your project. Click the individual cells of the table to type in text.

Page Flipper 
The Page Flipper moves you from one page of your design to another. For example, if you are making a greeting 
card, click the Page Flipper to move from the front cover to the inside of your card.

Note
· The Shaper tool can also be used to reshape photos that have been combined with other objects.
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The Notebook
The Notebook provides assistance with most Corel Print House tasks. It looks like a spiral-bound notepad and is 
located on the left side of the Corel Print House desktop.

Use the Notebook to

 access the catalog of Corel Print House resources such as Clipart, photos, borders, backdrops, and
phrases

 get assistance with tasks such as adding graphics, editing text, and saving and printing projects

 add coloring, shape, line, text, and shadow styles to your project
 

Moving through the Notebook
The Notebook is made up of three pages, each with different information. To open a specific page, click its tab.

The name of each Notebook page is displayed at the top of the page. Beside the name is the Back button 

. If you have gone through more than one Notebook page (e.g., Clipart, Animals, Farm Animals), you can click 
the Back button to display the previous page. The Back button does not display the previous page of a different 
Notebook tab (e.g., if you are on the Clipart page, and then switch to the Key page, the Back button is disabled).
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Key page

The Key page displays help topics to assist you with your current task. The topics shown are determined by the 
tool in use or the object selected. The Key page walks you through tasks using cue cards. Each cue card contains
an instruction. After each step is completed, a new card displays.
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Styles page

The Styles page contains preset coloring, line, shadow, text, and shapes styles you can use to enhance your 
projects. To apply a style to part of your project, drag the style’s icon from the Notebook onto the item you want 
to change. For example, to apply a specific coloring to a rectangle, simply drag the coloring icon onto the 
rectangle.

You can also save your own coloring, line, text, and shadow styles on the Styles page. Once you’ve created a 
style, open the appropriate page of the Notebook (e.g., To save a shadow style, click the Shadows button on the 
Styles page) and drag the object with the desired styles onto the Notebook page. The object’s attributes are 
saved, and you can name the style and reuse it with other objects.
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Catalog page

The Catalog page contains collections of Clipart, borders, backdrops, phrases, and photos. To add a Catalog item 
to your project, drag it from the Notebook onto the appropriate part of your design, or double-click the item in 
the Notebook.

The Catalog page also includes a section called the Scrapbook. You can use the Scrapbook to save pieces of your
own creations for later use. For example, if you create a logo, drag it onto the Scrapbook page so that you can 
add it to future projects.
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The Scrapbook
The Scrapbook is a part of the Catalog page where you can save your own artwork for later use. For example, if 
you create a logo, you can drag it into the Scrapbook and add it to future projects.
The Scrapbook is also a great way to save images from sample files that you want to reuse. If you find a greeting
card with a front page image that you’d like to include on a sign, on letterhead, or on another Corel Print House 
project, just drag the image to the Scrapbook.

Note
· You may need to group objects before dragging them to the Scrapbook. If you drag items that are not grouped,

each object is saved separately in the Scrapbook.
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The Property Bar

The Property Bar displays the properties for the selected text or graphic object. Properties are attributes such as 
coloring, line style, and positioning. From the Property Bar you can change the properties of the selected object.
To change an object’s properties, select the object with the Pick tool, and click the button on the Property Bar for 
the attribute you want to change.

Coloring button 
The Coloring button allows you to control the coloring of the selected object.

Line button 
The Line button allows you to control the style, width, and color of the selected line.

Shadows button 
The Shadows button allows you to control the characteristics of the selected shadow.

Fader button 
The Fader button allows you to control the relative fading of the selected object’s color.

Position button 
The Position button allows you to control the position of the selected object.

Size button 
The Size button allows you to control the size of the selected object.

Text Attributes button 
The Text Attributes button allows you to control the font style, size, and other characteristics of the selected text.

Corner Roundness button 
The Corner Roundness button allows you to control the roundness of the corners of the selected rectangle or 
square.

Ellipse/Pie/Arc button 
The Ellipse/Pie/Arc button allows you to control the characteristics of the selected ellipse, pie, or arc.

Polygon Sides button 
The Polygon button allows you to specify the number of sides for the selected polygon or star.

Number Of Rows/Columns button 
The Number Of Rows/Columns button allows you to control the size of the selected table.

Resize Rows/Columns 
The Resize Rows/Columns allows you to control the size of the table cells.



Note
· If no object is selected, the Property Bar is hidden.
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Controlling the Corel Print House environment
The Options dialog box contains the settings which affect how Corel Print House displays objects on the screen 
and how it performs certain operations. You can change these options to suit the way you work. For example, if 
you would like to be able to undo several actions instead of just your last action, you can change the Undo Levels
setting in the Options dialog box.
Options on the General page of the dialog box control the Notebook and desktop colors, levels of undo, page 
size, units of measure, startup options, and options for the Calendar and Manual Double-Sided Printing wizards.
Options on the Edit page of the dialog box control the placement of duplicates, nudge value, constrain angle, 
and line drawing options for corner threshold, auto close, and smoothness.
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Saving your work
Corel Print House offers you two ways to save your projects. You can save and organize your projects using the 
Save wizard, or you can use the Save command from the File menu. Both methods allow you to save your project
in the My Projects folder in the Corel Print House folder, in another folder, or on a floppy disk.
All Corel Print House files are saved with the .CPH file extension, which allows you to double-click a saved file in 
the Windows Explorer and launch Corel Print House. If you need to save your file in a format other than the Corel 
Print House format, use the Save As command from the File menu and choose a different file format.

The Save wizard
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Opening a file
Corel Print House offers you two ways to open your files and projects. You can open existing projects using the 
Open wizard, or you can use the Open command from the File menu. For file formats other than the Corel Print 
House .CPH format, use the Import command, which is also located on the File menu.

The Open wizard
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Viewing your work

Corel Print House provides three modes for viewing your projects on screen  Full Color, Coloring 
Book, and Grayscale.

Full Color mode displays your projects with all their color and outline attributes. Grayscale mode displays your 
project in 256 shades of gray and is useful if you want to see how your project will print on a black and white 
printer.
Coloring Book mode displays your projects in outline form. In other words, when you view your drawing in Coloring 
Book mode, you don’t see any fill or outline attributes. This mode allows for quick redrawing of your screen, making
it particularly useful when you’re working on a complex drawing. You can apply fill and outline attributes in Coloring 
Book mode, but you need to switch to Full Color mode to see them.

Corel Print House also provides the following tools that you can use to control how you view your projects:

Zoom tool
Magnifies selected parts of your project, or displays the full page or half of the page.

Scroll bars
Moves the Drawing Window horizontally and vertically.

Interruptible display
Allows you to select a menu command or tool without waiting for the screen to redraw completely.
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Setting up the page



Page layouts
Corel Print House allows you to specify the page orientation and size for your project. You can choose between 
portrait (vertical) or landscape (horizontal) orientations, and also specify the exact size of the project you wish to
create. Paper size is limited by your printer driver. You can set page layout from the Create wizard or by choosing
Page Setup from the File menu.

Printable region
Most printers leave an unprinted area around the outside of the page, meaning that the printable region is 
slightly smaller than 8.5” x 11”. If you place text or graphics too close to the edge of the page, you may find that 
they are cropped by the printer because they fall outside the printable region.
To help you position your artwork, Corel Print House displays the printable region. A dashed line appears around 
the border of your page, showing the printable region for your default printer. The dashed line appears on screen
only and does not appear when you print your project. You can disable the Printable Region command on the 
View menu.
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Clipart, borders, backdrops, phrases, and 
photographs



Using Clipart, borders, backdrops, photographs, and phrases
Corel Print House comes with professionally designed Clipart, borders, backdrops, photographs, and phrases to 
complete your creative designs. By opening the Notebook’s Catalog page, you can choose from over 7000 pieces
of Clipart, 1000 phrases, 1000 photos, 200 backdrops, and 70 borders. They’re all organized by categories so it’s
easy to find the one that’s right for you.
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Using Clipart
Each Clipart object is made up of one or more graphic objects which have been grouped together. You can 
ungroup a piece of Clipart and edit the pieces individually.
For example, if you have a Clipart image of a house and want to change the color of the roof, use the Ungroup 
command to break the house apart into separate pieces. You may have to use the command a number of times 
to break down all the groups and subgroups of objects.
You may want to use the Group command to regroup all the pieces of the Clipart object when you’re done so that
you can save the new graphic in the Scrapbook. Grouping the pieces together also makes it easier for you to 
move and resize the graphic without excluding any pieces.
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Using backdrops
Backdrops are large pieces of Clipart that you can use to fill in the background of a page. When you choose a 
backdrop, Corel Print House positions it on the page for you, and places it behind your other objects. If you want 
to edit the backdrop, click the Merge Backdrop command in the Tools menu. Otherwise, the backdrop stays in the
background, and won’t get in the way as you select and edit other objects. To fade a backdrop, merge it with 
your project and then use the Fader button to lighten it.
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Using borders
Corel Print House borders are called intelligent borders because you can resize them in two ways: according to 
the size of your page, and according to the size of the objects that make up the border. If you want to resize the 
perimeter of a border, use the Pick tool; if you want to resize the objects that make up the border, use the 
Shaper tool. The objects are grouped so that when you use the Shaper tool, all objects in the border are resized 
together.
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Using phrases
Each phrase has two components: front and inside. You can use both components of a phrase on your card, just 
one component, or mix and match front and inside elements from different phrases. When you add a phrase to a
project, it uses the current text properties. You can edit and style the phrase text as you would any other text.
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Using photos
Photos are bitmap images and have different properties than vector images such as Clipart. Although you can 
reshape, resize, and add shadows to photos, you can’t use Corel Print House to edit the colors or content of the 
photo itself. However, by clicking your right mouse button, you can send any photo or other bitmap image to 
Corel Photo House. Corel Photo House allows you to retouch and edit photos to correct photographic problems 
such as red eye and underexposure, and create special effects like page curls and embossing. Read the Corel 
Photo House online Help for more information about the range of photo-editing tools available to you.
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Creating graphic objects

What are graphic objects?
Graphic objects are the building blocks of each project. Everything you place or create on your page is an object,
including lines, graphics, and strings of text. Objects are constructed from paths which determine their shape. 
Each object has an outline and can be filled with color.

Creating objects
You can create objects easily by following the instructions in the Corel Print House Notebook, or you can add 
previously designed objects such as Clipart, borders, backdrops, and phrases from the Catalog. Regardless of the
method you choose, Corel Print House makes it easy to insert objects and design your own project.

Using the drawing tools
Corel Print House provides a variety of tools that you can use to create graphic objects. The Freehand tool allows 
you to create graphic objects line by line, or curve by curve. For example, you can draw irregular shapes or sign 
your name. The Rectangle, Ellipse, and Polygon tools allow you to create graphic objects by clicking and 
dragging. For example, you can create a circle with the Ellipse tool or a ten-sided star with the Polygon tool.
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Adding text
Corel Print House's powerful text-handling capabilities let you add and manipulate text with ease. You can type 
Artistic text or Paragraph text directly into your projects and use the built-in spelling checker to proofread your 
project.

Artistic text
Artistic text is suitable for small amounts of text such as a single word or sentence. Artistic text can be fit to a 
path, which means that words wrap around a graphic object or line that you specify. For example, if you fit 
Artistic text to a circle, the text follows the circle's shape. The Fit Text To Path dialog box gives you several 
options for positioning your text, including the option to place text inside the graphic object.

Another feature of Artistic text is that you can convert it to curves. Once you convert text to curves, you can use 
the Shaper tool to reshape letters as though they were lines or graphic objects. Text that has been converted to 
curves cannot be edited with the Text tool.

Paragraph text
Use Paragraph text for adding large blocks of text to your ads, brochures, and other projects. Corel Print House 
hyphenates Paragraph text automatically. Although you can't fit Paragraph text to a path as you can with Artistic 
text, you can use shapes to mold your paragraphs into different forms as shown below. You can also use the 
Shaper tool to rearrange Paragraph text letters, or use the Pick tool to rotate and skew the text.

Editing and formatting text
Some of the formatting you can apply to text includes changing the font, point size, and attributes. As long as 
you don't convert it to curves, text remains editable even after you transform or apply special effects to it. For 
example, if you have fit text to a path, you can still insert your cursor in the text and edit it, and the Spelling 
Checker will still check the text for spelling errors.

Changing the outline and fill of text
As with other objects, text and symbols are given a default outline and fill. You can change the outline and fill of 
any object from the Property Bar or using the Coloring and Line wizards.
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Spell checking your projects
Corel Print House includes a powerful spelling checker that detects and corrects numerous types of spelling 
errors. You can install additional language dictionaries by running the Corel Print House install program and 
choosing the Custom install option.
The Spelling Checker allows you to add your own words to the dictionary (e.g., you can add your name so that 
the spelling checker doesn’t stop on it all the time) and includes a Rule Manager so you can choose which types 
of errors to include or ignore.
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Creating tables
If you need to organize information into rows and columns, you can create a table in your Corel Print House 
project. Tables are useful for brochures, invoices, and other documents where you need to present detailed 
information such as prices, model numbers, dates, times, names, addresses, and phone numbers.
Once you create a table you can type text in the table cells, color the table with solid or gradient fills, change its 
line attributes, and use the Pick tool to move and resize the table. You can change the number of rows and 
columns in the table at any time, and resize the table cells to fit your data.
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Default properties
In Corel Print House, the default properties are always the properties of the object you last selected. For 
example, if you type some text, change the font size to 36 points and continue typing, then click on a new spot 
on the page and type some more, the new text will be at 36 points.
Below are some additional examples:
· If you have two lines of text on screen, one black and one red, select the black text (using either the Pick tool 

or the Text tool), and type somewhere on the page, the new text will be black. However, if you next place the 
cursor in the middle of the red text object, you will type in red.

· If you draw a five-sided polygon and change it to 13 sides, the next polygon you draw will have 13 sides.
The only exception to these examples is that text, graphic objects, and tables do not share color and outlines. As
a result, the default properties for any new text are always the properties of the last text item you selected. 
Similarly, the default properties for any new graphic object are always the properties of the last graphic you 
selected.
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Arranging objects



Selecting objects
Before you can do anything with an object, you need to select it with the Pick tool. Once selected, you can 
change the object's appearance and position. Corel Print House provides three ways to select objects:
· clicking objects with the Pick tool. If the object has a colored fill, you can click anywhere on the object's fill or 

outline. If the object is unfilled (has no color), click anywhere on its outline.
· dragging a box (called a marquee) around the object(s) with the Pick tool. Holding down ALT as you marquee 

select allows you to include all objects touched by the marquee box, even those that are not completely 
enclosed. Marquee selecting is a good way to select several objects at once.

· using the Select All command on the Edit menu, which selects all objects on the current page
When an object is selected, eight sizing handles appear at the corners and midpoints of an otherwise invisible 
rectangle. This rectangle is called a highlighting box.

Selecting text
You can select text in two ways:
· the same way you select graphic objects, tables, and photos as described above. If you select text using this 

method, you can change the properties (font, color, size, etc.,) for the entire text object.
· by dragging the text cursor over the text to select characters and words. If you select text with this method, 

you can change the properties for the selected text, or type over the selected text to replace it.
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Moving, copying, and deleting objects
Corel Print House provides effective tools for moving, copying, and deleting objects in your projects. These tools 
are easy to use, yet provide powerful ways to create, manage, and manipulate your drawings.

Moving objects
There are two methods for moving objects in Corel Print House: dragging them with the Pick tool, or using the 
Position button on the Property Bar. Dragging objects is an easy method for moving objects around and 
experimenting with different layouts. When you need more precision in placing objects, you can click the Position
button and type in exact coordinates for an object.

Cutting, copying, and pasting objects
The Cut, Copy, and Paste commands let you copy selected objects to and from the Windows Clipboard. From 
there, you can paste them into your current project, another project, or another Windows application.
The Duplicate command adds a copy of the selected object to your project, without placing a copy on the 
Windows Clipboard. You can use this command in place of the Copy and Paste commands when you want a copy 
of an object on the same page as the original object.
The Delete command removes the selected object from your project without placing a copy on the Windows 
Clipboard. If you aren't sure about permanently deleting an item, you can use the Cut command instead. The Cut
command also removes the selected object, but it places a copy of the object on the Clipboard. The Clipboard 
contents can be retrieved using the Paste command.

 Tip
· If you make a mistake while performing any of these operations, you can click Edit, Undo to reverse the 

operation.
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Grouping and combining objects

Grouping objects
The Group command lets you bind objects together and manipulate them as a single unit. For example, most 
pieces of Clipart are actually several objects that have been grouped together. You can use the Ungroup 
command to separate grouped objects when you want to edit them.

Combining objects
The Combine command lets you join curve and/or line segments, thereby creating a single curve object. If you 
use the Combine command on rectangles, ellipses, photos, or text objects, Corel Print House converts them to 
curves, then converts them to a single curve object. If you use the Combine command on overlapping objects, 
you create clipping holes.
When you combine objects with different fills and outlines, Corel Print House fills and outlines the combined 
object using the attributes of the last selected object. If you marquee select the objects, Corel Print House uses 
the attributes of the bottom object.
Combining objects can provide many benefits, including
· conservation of memory for graphics that contain many lines and curves
· joining two line or curve segments
· creating clipping holes or masks
· aligning nodes in different objects
You can use the Break Apart command to separate combined objects. When you separate the objects they 
remain curve objects, regardless of what they were before they were combined.
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Ordering objects
A Corel Print House project can be described as a series of layers containing objects stacked on top of one 

another. The order of these objects  the stacking order 

 determines their final appearance. The stacking order is evident when you display or print 
overlapping objects with contrasting properties. An object that's higher in the stacking order appears and prints on 
top of those lower in the order. If objects do not overlap, the stacking order isn’t obvious and neither is the effect of 
changing their order.

For example, if you have a circle and a square which overlap, their stacking order affects their appearance.

 
The ordering commands in the Arrange menus let you change the stacking order. You can move any object within 
the stacking order using the To Front, To Back, Back One, and Forward One commands. Grouping objects puts them 
in the same position in the stacking order. If you select more than one object and choose any of the order 
commands, the objects move together and keep the same relative order.
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Aligning and distributing objects
You can align and distribute selected objects horizontally and vertically using the Align And Distribute dialog box.
Objects can be aligned by their left, right, top, or bottom edges, or by their center points, or distributed 
horizontally and vertically.
The Align And Distribute dialog box contains two check boxes:
· Align/Distribute To Page distributes the objects evenly over the page. 
· Align /Distribute To Selection distributes the objects over the area occupied by the selected objects.
The Preview window in the dialog box shows the general effect of each alignment and distribution option (or 
combination of options), but is not meant to accurately reflect the size or exact location of your objects.
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Changing the appearance of objects



Sizing, rotating, and skewing objects
Corel Print House allows you to change the size, orientation, and appearance of an object without altering its 
basic shape. You can resize, rotate, or skew an object or groups of objects simply by dragging their handles with 
your mouse. For more precision, you can use the Size button on the Property Bar to enter exact measurements 
for objects, and the Rotate command on the Arrange menu to rotate objects in 90 degree increments.
You can creates mirror images of objects and photos using the Flip Horizontally and Flip Vertically commands on 
the Arrange menu.

Note
· If you make a mistake while performing any of these operations, you can click Edit, Undo to reverse the 

operation.
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Outlining objects
Every object has an outline that you can manipulate in a variety of ways. Think of each object as being drawn 
with a pen that changes size, shape, and color. You can use round or square, slanted or symmetrical, thick or 
hairline-thin nibs to draw dashed, dotted, solid, or calligraphic lines.
In addition to the shape and color of the nib, you can also change the ending shape of an outline. Lines or 
objects with open paths can have ends that are rounded, square, cropped, or tipped with arrowheads and other 
line-ending shapes. Objects with closed paths (squares, polygons, etc.) naturally have no end-points, but you can
still choose from pointed, rounded, or truncated corners.
The outline attributes of the current object are always displayed on the Property Bar. You can change the 
attributes using the Line dialog box or the Line wizard.
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Changing the shape of objects
Corel Print House allows you to change the shape of any object. Objects created in Corel Print House are 
constructed from basic elements called paths. A line, for example, is a path drawn between a start point and an 
end point. Each point is called a node. A line is an open path that cannot be filled. A closed path (e.g., a circle) 
can be filled.

With the Shaper tool  you can reshape an object by changing the characteristics of the paths and 
their nodes. To edit the paths and nodes of an object, convert the object to curves using the Convert To Curves 
command in the Arrange menu. This step isn't necessary for objects drawn with the Freehand tool because they 
are already curve objects.
Three special types of shaping don't require converting the object to curves:
· rounding the corners of rectangles and squares
· creating arcs and pie wedges from ellipses and circles
· mirror editing objects created with the Polygon tool

Notes
· You cannot edit text after you convert it to curves.
· You cannot convert groups of objects to curves.

 Tips
· You can also use shape styles from the Notebook to reshape objects.
· Double-clicking any graphic object activates the Shaper tool and allows you to begin node editing.
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Using shapes
Shapes can be used to shape text (Artistic and Paragraph), graphic objects, and photos. The Styles page of the 
Notebook contains several shape styles you can drag onto elements of your project. For example, if you want the
phrase on the front of a greeting card to be printed in the shape of a star, just drag a star shape out of the 
Notebook onto your phrase.
Shape styles provide an easy way to reshape objects without having to use the Shaper tool, and are great for 
adding special effects to text. Try creating a few lines of text in a large font (e.g., 72 points or higher) and then 
applying a shape style to it. Some shape styles were designed for Paragraph text (longer text) while others were 
designed for Artistic text (shorter text), photos, and graphic objects.
You can create your own shapes in three ways:
· using the Add Shape command from the Tools menu
· dragging graphics objects and Clipart onto the Shapes page of the Notebook
· combining a graphic object with Paragraph text
The Add Shape command places a rectangle shape with eight handles on an object and selects the Shaper tool. 
You drag the handles to create the desired shape, and then drag the shape to the Shapes page of the Notebook 
for future use.
When you drag Clipart into the Notebook, Corel Print House combines the objects within the Clipart object to 
create a shape. Some Clipart objects may be too complex to use as shapes and cannot be dragged to the Styles 
page.
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Using shadows
Shadows allow you to add depth and color to Artistic text, graphic objects, and photos. You can add shadows 
using the Shadows button on the Property Bar, or using the shadow styles in the Notebook.
Although you can use any shadow style from the Notebook on any text or graphic object, some styles were 
designed for Artistic text, while others were designed for graphic objects and photos. Shadows on Artistic text 
must be created carefully so that the text remains readable.

Shadows can be one color or a blend of two colors if you have more than one shadow. You can also control a 
shadow’s length and angle, as well as skew and scale the shadow just like a graphic object. The Preview window in 
the Shadows dialog box makes it easy to drag the shadow into position.
If you create a shadow style that you want to use on other objects, drag the shadowed object onto the Shadow 
Styles page of the Notebook.

Shadow style names
The shadow styles in the Notebook are named in the following manner:

Text Shadows
· Color(s), angle, number of shadows

For example Blue 45d 6 creates a blue shadow at 45 degrees to the object, with 6 shadows.

Object shadows
· Color(s), direction, number of shadows

For example Pink NE 4 creates a pink shadow in a North East direction from the object, with 4 shadows.
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Filling or coloring objects
Any object with a closed paths can be filled in with a solid color or a gradient fill. If you don't fill an object, or you 
remove an object's existing fill, objects behind the unfilled object show through as if the unfilled object were 
transparent. You can fill objects with color using the Color wizard, by clicking the Coloring button, or by using the 
coloring styles in the Notebook.

Solid fills
You can quickly fill an object with a solid color using the Coloring button on the Property Bar or the coloring styles
in the Notebook. To create custom colors, click the More button on the color palette.

Gradient fills
A gradient fill is a progression of colors following a circular, square, straight, or radial path. The start and end 
colors you choose are gradually blended together in the path you choose. Some of the preset gradient fills in the 
Notebook create effects that resemble neon tubes, metal cylinders, and other similar effects.

Rainbow fills
A rainbow fill is a special type of gradient fill that you create by clicking the clockwise or counterclockwise 
buttons in the Coloring dialog box or Coloring wizard. The start and end colors you choose are blended together 
using the colors of the rainbow (red, orange, yellow, green, blue, indigo, violet), creating a cascade of colors. For 
example, if you choose a start color of red and an end color of violet, the colors of the rainbow that fall between 
red and violet are used to blend the colors.
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Fading objects
Corel Print House allows you to lighten or darken any text or graphic object, or any photo using the Fader button 
on the Property Bar. Fading Clipart and photos is a great way to create a background for other elements in your 
project. If you have a page that looks a bit empty, a faded graphic can add subtle color and interest to your page
without obscuring your text.
The Fader button can also be used to make objects darker. If you have a piece of Clipart which seems too bright, 
but you don’t want to try to edit the individual colors in the objects, you can darken the entire object using the 
Fader button.

{button ,AL(`Changing the appearance of objects;',0,"Defaultoverview",)} Related Topics



Accessing the color palette and color models
Corel Print House provides a color palette to make it easy for you to add colors to your projects. Clicking the 
Coloring button on the Property Bar opens the Coloring dialog box, which you can use to fill your object with a 
solid color or gradient fill, or to remove a color from an object.
If you wish to create your own color, you can choose from two color models: HSB and RGB. Both are accessed 
from the Coloring dialog box

 Using the HSB color model

When you click the More button in the Coloring dialog box, the More - HSB dialog box opens. The Hue, 
Saturation, Brightness color model is the closest approximation to how we perceive color. Hue determines the 
color, saturation determines the color depth, and brightness determines the percentage of white used to make 
the color lighter or darker. 

 The circular selector adjusts the hue.

 The triangular selector simultaneously adjusts saturation and brightness.

 Using the RGB color model



You can access the RGB color model by clicking the RGB button in the More - HSB dialog box. The Red, Green, 
Blue color model is based on the light primary colors and is appropriate for images that are displayed on a 
monitor or on transparent media such as slides.

 The sliders adjust the amount of red, green, and blue (from 0-255) that make up the final color.
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Color Palette

 Using the color palette

 Click the Presets button to open the pre-defined colors stored in the Notebook.

 Click the Keep button to store the color you chose in the Notebook.

 Click the Key button 

 to launch the Coloring wizard.



Understanding color models

What are color models?
Color models are mathematical representations of a color space. They provide a standard against which we can 
measure color, and a system through which mechanical devices can reproduce color.
Models tend to be based on three primaries, which corresponds to the tristimulus base of human vision. Each 
primary in the model is assigned a value within a specific range, and the combination of values determines the 
color. This is similar to the exercise we did as children, in which we mixed the pigment primaries of blue, red, and
yellow to form what we called secondary and tertiary colors.
Even though models express color numerically, they are imperfect since color is affected by our perception. 
However, color models can be used in computer applications to define color output. If we send a color signal 
R255G000B255 to any monitor properly calibrated against a reference point, we will (in theory, anyway) always 
measure the same color (magenta, in this case).

Corel Print House’s color models
Corel Print House uses the HSB (Hue, Saturation, Brightness) and RGB (Red, Green, Blue) color models. The HSB 
model is a variation of the RGB model; both are based on the light primaries. Of all color models in use today, 
HSB most closely represents the way in which we perceive color and presents an intuitive method of defining 
color. The RGB model is used to more accurately define colors for images that are displayed on radiant devices 
such as computer monitors and television screens, or on transparent media such as slides.
Hue defines the actual color (red, yellow, etc.) in much the same way that you often see colors around the 
periphery of a color wheel.
Saturation defines the purity of the color. As you move across the color wheel (as opposed to around it), you are 
removing a percentage of the color you are moving away from and adding a percentage of the color you are 
moving toward. As you move toward the center of the wheel, the color becomes increasingly gray due to equal 
percentages of the light primaries.
Brightness defines the amount of lightness in the color on a vertical scale (lightness can also be equated with 
the amount of white in the color). The brightness component is non-linear, which closely approximates how we 
see light and dark colors. As you move down the scale toward the dark area, the physical distance covered 
decreases for the same numerical value change.
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Scanning images



Scanning images into Corel Print & Photo House
If you have a TWAIN compatible scanner, you can scan images directly into Corel Print & Photo House. You have 
the option of using your scanner’s own drivers and interface or the Corel TWAIN interface. To use the Corel 
TWAIN drivers, you must install them during the Corel Print & Photo House installation process. To install your 
scanner’s own TWAIN driver and interface, consult the documentation that came with your scanner. If desired, 
you can install both types of drivers and select which one to use by clicking File, Acquire Image, Select Source.
The Corel TWAIN interface sets up a connection between your scanner and Corel Print & Photo House. Using 
Corel TWAIN’s Prescan feature, you can preview images before you scan them. This allows you to adjust the 
scanning parameters, such as Color Depth and Resolution, to enhance image quality.
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Improving image quality
To get the best possible scan, you should start with a high quality original. However, if you have to scan a poor 
quality image, most scanners provide tools to help you improve the look of the scanned image.
One common problem with images is what professional photographers refer to as “flat” images, meaning that a 
picture has very little contrast. By adjusting the contrast or brightness when scanning, you can increase the 
differences between highlights and shadows to give the image the appearance of more depth. These features 
can also be used to enhance over or underexposed images.
Often, images that are damaged or older may have poor color quality (e.g., sepia tones or faded color). In this 
case, you may be able to adjust the balance of color in the scanned image.
Faded or blurred images can be enhanced by increasing the resolution or color depth of the scan. This helps 
sharpen edges and increase the distinction between colors.
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Customizing an image
Depending on your needs, you may want to change the original image or use only portions of it in your 
document. Most scanners provide editing features that allow you to customize scanned images by rotating, 
flipping, or cropping them. This allows you to fit the picture into your project and eliminate any unwanted areas 
from your final scan.
You can also convert color images to black and white if your scanner provides a Color Depth feature. Depending 
on the color depth you choose, this conversion can reduce the size of your file.
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Selecting a resolution
Scanning resolution is measured in dots per inch (dpi) and determines the amount of detail visible in an image. 
To get the best possible results, you should carefully choose the resolution best suited to the image you’re 
scanning. 
It is not always necessary to choose the highest possible resolution to get a good quality scan. If the image has 
little detail or is only black and white, you can use a lower resolution. This helps reduce the size of the file, as 
images scanned at higher resolutions require more disk space.
You should also consider the capabilities of your output device. If you intend to print the scanned image, you 
should try to match the scan resolution to your printer’s capabilities. An image scanned at 600 dpi and printed 
on a 300 dpi printer results in a 300 dpi image. If you intend to edit the image with photo-editing software, the 
scan resolution you choose should be appropriate for your monitor. For example, if you scan an image at 600 dpi 
and display it at a lower resolution, you won’t see all the information, which could make editing details difficult.
When choosing a resolution, try to get the highest possible image quality without making the file any larger than 
necessary.
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Selecting an original
The quality of your scanned image depends on the quality of the original image. When choosing an original, you 
should try to avoid images that are damaged or stained. Rips and tears in an image can sometimes be corrected 
using photo-editing software.
If you’re using a photograph, examine it closely to make sure that it’s clearly focused. Photo-editing software 
may be able to correct a photo that is slightly out of focus, but not one that is completely out of focus. Also, 
avoid photographs that are over    or underexposed. You can use your scanner’s features to adjust the contrast, 
but you cannot highlight details that are not in the original.
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Selecting a color depth
Color depth determines the range of colors and tones that are visible in an image. It is usually measured by the 
number of colors displayed (e.g., 256 colors, or 16 million colors). When choosing a color depth, you should 
consider the purpose of the image. If it is to be used to fill an entire page, you should use the highest possible 
color depth. However, if the image is going to be small, a lower depth may give you adequate results while 
saving on file size.
As you decrease the color depth, details in darker areas may be lost. You may want to use a higher color depth 
for detailed images even if the images have a small color range. Scanning at a higher color depth may also save 
you from having to do extensive color correction using photo-editing software.
Keep in mind that the image will only appear as good as your output sources will allow. It may be a waste of disk 
space to scan an image at a high color depth if the monitor or printer you’re using is not capable of producing 
such a wide range of color.

Color depth and Corel Photo House
If you’re planning to scan an image into Corel Photo House and apply Touch-Up and Cool & Fun effects to it, you 
should choose the highest color depth available. For example, if you’re scanning a black and white photo that 
will be printed on a black and white printer, you may be tempted to choose a color depth of 256 shades of gray. 
However, you’ll find that Corel Photo House effects work better on images with a color depth of 16 million colors,
even if the image itself does not contain any color. In addition, if you decide that you want to add some color to a
grayscale image (e.g., to create a hand-painted look) it is not possible to add color to an image with a color 
depth of 256 shades of gray.
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Printing your work



Printing your work
Corel Print House offers you two ways to print your projects. You can use the Print wizard to guide you through 
the selection of print options, or you can use the Print command from the File menu. Both methods allow you to 
choose from a variety of print options printer selection, paper size and orientation, number of copies, placement,
print style options, and the option to merge your project with a Namelist. You can even print your projects in 
Coloring Book mode and color them by hand. In addition, Corel Print House makes it easy to print your projects 
directly on PaperDirect paper.

Printable region
Most printers leave an unprinted area around the outside of the page, meaning that the printable region is 
slightly smaller than 8.5” x 11”. If you place text or graphics too close to the edge of the page, you may find that 
they are cropped by the printer because they fall outside the printable region.
To help you position your artwork, Corel Print House allows you to display the printable region. If you enable the 
Printable Region command on the View menu, a dashed line appears around the border of your page, showing 
the printable region for your default printer. The dashed line appears on screen only and does not appear when 
you print your project.

Continuous feed paper
If your printer supports continuous feed paper, and you enable the continuous feed option in your printer's 
properties, Corel Print House detects that you are using continuous feed paper. There is no need to change the 
setup of your project.

Printing considerations
· Make sure the typefaces and point sizes you choose are suitable for the paper you will be printing on. For 

example, delicate typefaces or small point sizes may not reproduce well and may be difficult to read on 
textured, colored, or speckled paper.

· Try to keep the number of nodes per object to a minimum, especially when using a level 1 PostScript printer.
· You should also delete all unnecessary elements to reduce the size of your file. Remove any redundant objects 

hidden behind other objects and any leftover objects outside the drawing page.
· The larger the bitmap or graphic, the more RAM it will use and the larger the file will be.
· If you are printing complex graphics, you may need to adjust the printer’s settings. 
· Will you be using coated or uncoated paper? Matte or glossy paper? Newsprint? Textured paper? Recycled 

paper? The paper stock you choose significantly affects the quality of your final product.
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Folding your projects
Some projects need to be folded after you print them, including
· greeting cards
· brochures
· some menus
· cut and fold envelopes
· note cards
If you are unsure of how to fold your particular project, instructions are available in the online help. You can also 
use the Folding Demonstrations command on the Help menu to access videos to assist you with folding greeting 
cards, brochures and menus.
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Using Namelists
Corel Print House allows you to merge data (e.g., names and addresses) contained in a Namelist with your 
project. For example, if you need to print address labels for a group of people, create a Namelist with their 
names and addresses. Then, create a label project, but instead of typing the name and address for each person, 
use the Use Namelist Field command to specify which fields to include on the label. Your finished project might 
look something like this:
<<First Name>><<Last Name>>
<<Address>>
<<City>>, <<Prov>>
<<Country>>
When you print the project, enable the Use Namelist option so that the information from your Namelist is used in 
place of the Namelist field names.

Creating Namelists
You can create Namelists in Corel Print House using the Namelist wizard. You can also use the Namelist wizard to 
import data from other applications to create a Namelist.
Any Tab Separated data that has been saved as ASCII text (text only) can be imported using the Namelist wizard.
Text can be imported from word processors such as Corel WordPerfect, or spreadsheets such as Corel Quattro 
Pro. Below is an example of data in the Tab Separated format:
Name Address City Prov/State Country
Sarah 16 Ventura Blvd. Ottawa ON Canada
Shane 6 Draw Lane Toronto ON Canada
Dave 2 Flow Rd. Orem UT USA
Tasha 55 Gallery Ave. Orem UT USA
Mark 95 Xara St. Dublin Ireland
Sandra 12 Presents Ct. Dublin Ireland

Note
· A Tab Separated file is an ASCII text file consisting of a series of data fields separated by the tab character. A 

record consists of multiple fields ending with a hard return or paragraph marker. The first row of data must be 
the field names or headings.
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Menu command shortcut keys
You can use the following keystrokes to access the menu commands listed below.

File
New CTRL + N
Open CTRL + O
Save CTRL + S
Print CTRL + P

Edit
Undo CTRL + Z
Redo CTRL + SHIFT + Z
Cut CTRL + X
Copy CTRL + C
Paste CTRL + V
Delete DELETE
Duplicate CTRL + D
Select All CTRL + A

View
Zoom In F2
Zoom Out F3

Arrange
To Front SHIFT + PAGE UP
To Back SHIFT + PAGE DOWN
Forward One CTRL + PAGE UP
Back One CTRL + PAGE DOWN
Align And Distribute CTRL + L
Group/Ungroup CTRL + G
Combine/Break Apart CTRL + K
Convert To Curves CTRL + R

Tools
Fit Text To Path CTRL + F
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Notebook shortcut keys
You can use the following keystrokes to access the Notebook pages listed below.
Key Page F4
Coloring F5
Lines F6
Shadows F7
Shapes F12
Text F8
Clipart F9
Scrapbook F10
Phrases F11

{button ,AL(`Menu command shortcut keys;Toolbox and Property Bar shortcut 
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Toolbox and Property Bar shortcut keys
You can use the following keystrokes to access the tools and dialog boxes listed below.

Toolbox shortcut keys
Key CTRL + 1
Pick CTRL + 2
Shaper CTRL + 3
Text CTRL + 4
Freehand CTRL + 5
Rectangle CTRL + 6
Ellipse CTRL + 7
Polygon CTRL + 8
Table CTRL + 9

Page Flipper shortcut keys
Next Page PAGE UP
Previous Page PAGE DOWN

Property Bar shortcut keys
Coloring CTRL + SHIFT + 1
Line Style CTRL + SHIFT + 2
Shadows CTRL + SHIFT + 3
Fader CTRL + SHIFT + 4
Context Sensitive CTRL + SHIFT + 5
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Spell checking dialog box
The Spell checking dialog box detects and corrects numerous types of spelling errors, including those related to 
language-specific phenomena such as compound words in the Germanic languages. The spelling checker 
corrects errors involving the following categories of writing elements:
· A/An use (English)
· Capitalization
· Spelling (abbreviation errors, apostrophe errors, cognitive misspellings, and typographic errors)
· Clitics (Romance languages)
· Compounding (English and the other Germanic languages)
· Doubled words
· Hyphenation (including soft-hyphen errors and hyphenation-dependent spelling errors)



Rule Manager
The Rule Manager gives you the ability to turn off rule types and to use different combinations of rule types when
writing for different readers. It keeps track of which rule types you have turned off, and whether you want to do 
this for the current writing session and/or for future writing sessions. If you turn off rule types for future sessions,
the Rule Manager maintains a list of these in a user profile and reloads it when the next writing session starts. If 
you turn off a rule type for the current session only, the Rule Manager discards the information at the end of that 
session.
The Rule Manager displays a description of each Rule Type when highlighted in the Rule Manager dialog box or 
when an error is found during spell checking.



A/An use (English)
During proofreading, the Spelling checker identifies all errors involving the words "a" and "an".

Error Correction
an European country a European country

Capitalization errors
In addition to flagging all capitalization errors identified during a spelling check (including errors in proper 
nouns), the Spelling checker flags errors in the following categories:

Compass points
Error Correction

English in the South of France in the south of France
in the north in the North

First word in a sentence
Because the Spelling checker processes text sentence by sentence, it recognizes the first word in each sentence 
and flags it if it is not capitalized.

Language-specific capitalization
Error Correction

English Summer summer
French Mardi mardi

Janvier janvier
German Montags montags

Word groups
Error Correction

English mount Everest Mount Everest
New Year’s day New Year’s Day
New York state New York State
State of New York state of New York

Portugues dia das mões Dia das mões

Clitic errors (Romance languages)
Clitics are articles, pronouns, or prepositions that are attached to other words for grammatical reasons. The use 
of clitics in the Romance languages supported by the Spelling checker involves language-specific changes in 
spelling and accents.
In French, for example, certain grammatical constructions require that articles or pronouns called preclitics be 
attached to the beginnings of words in specific ways, while other constructions require that pronouns or other 
forms called postclitics be attached to the ends of words. The French words le 'the' and enfant 'child', for 
example, are combined in the cliticized form l'enfant 'the child', and donnez-le-moi 'give it to me' has two 
postclitics, -le 'it' and -moi 'me'. In Spanish, equivocarse 'to be mistaken' combines the verb equivocar 'to 
mistake' with the pronoun se 'oneself'. In Italian, ciascun'amica 'each (girl) friend' combines the adjective 
ciascuna 'each' with the noun amica '(girl) friend'.
Strict and complex rules govern the combination of stems and clitics in each Romance language. These rules 
take into consideration the part of speech of the clitic (article, pronoun, or preposition); its position (preceding or 
following the stem); the phonetic value (vowel or consonant) of the initial or final letter of the stem; and the 
gender, number, and grammatical role of the stem. Consequently, spelling verification for these languages 
requires special checking. The spelling checker can do the following:



Verify correct clitics
All of the following are correct and are verified as such by the Spelling checker: 

French envoyez-les-lui [envoyez + les + lui] 
l’ordinateur [le + ordinateur] 

Italian portarglielo [portare + glie + lo] 
senz’alzarsi [senza + alzare + si] 

Portuguese aprendê-lo-ei [aprenderei + o] 
Spanish dámela [da + me + la] 

Flag incorrect clitics
In these examples, the stem is correct, but the attached clitic is not. The Spelling checker detects these errors:

French s’ordinateur (an error for l’ordinateur) is flagged as having an inappropriate 
preclitic

veut-t-il (an error for veut-il) is flagged as having an inappropriate postclitic

Flag and correct unmodified stems
In these examples, the stems should have been modified when the clitic was attached: 

Error Correction
Italian senz’alzaresi senz’alzarsi 
Portuguese dás-lo dá-lo 
Spanish mostrémossela mostrémoselas 

aislémosnos aislémonos 

Flag and correct apostrophe errors
In these examples, an apostrophe should have been inserted or omitted: 

Error Correction
French lenfant l’enfant 

l’ettre lettre 
Italian lormai l’ormai 

l’aureato laureato 

Flag and correct accent errors
In these examples, an accent should have been inserted or omitted:

Error Correction
Portuguese faz-lo fá-lo 
Spanish aíslemonos aislémonos 

Flag and correct stems with clitics
These examples contain errors in the stems:

Error Correction
French n’appèl n’appelle 
 appellez-vous appelez-vous 
Italian t’arabiare t’arrabbiare
Portuguese escreber-nos escrever-nos 

Compounding errors (English and the other Germanic languages)
In English, the spelling checker flags and corrects errors that occur when writers mistakenly hyphenate a word, 
as in the following example:
Error Correction
blue-prints blueprints



In the other Germanic languages supported by the spelling checker (Dutch and German), two or more words can 
be joined to form a single word, or compound. German Lebensfreude 'joy of living', for example, is a compound 
of Leben and Freude. 
Some compounds are well established and commonly used; however, new compounds that follow language-
specific rules are constantly formed. Spelling software for Germanic languages must account for this productive 
and rule-governed process. The spelling checker lists the most frequently used compounds in its databases. Less
frequently used compounds are verified by confirming that they consist of grammatically valid elements. This 
process enables the Spelling checker to verify most two-part compound words. Also, because the database 
stores many common two-part compound words as valid compound components, the Spelling checker can also 
verify many three-part compounds. The Spelling checker can do the following:

Verify newly formed compounds
Dutch bondsbureau financieringsondernemingen
German Textverarbeitung Computerrevolution

Verify compounds formed with acronyms
Dutch KLM-piloten 
German ASCII-Format

Flag and correct misspellings of compounds
Dutch bondsgenootscha bondgenootschap 
German Mietkasernen Mietskasernen

Doubled-word errors 
Dutch flags doubled words other than dat dat, die die, je je, and other personal pronouns
English flags doubled words other than that that and had had
French flags doubled words other than vous vous, nous nous, and en en
German flags doubled words other than der der, die die, das das, and sie sie
Italian flags doubled words other than via via, passo passo, and sotto sotto
Portugue flags doubled words other than se se and agora agora

Hyphenation errors
The spelling checker's hyphenation processing enables it to detect the following types of hyphenation errors:

Soft-hyphen errors
A soft hyphen is a hyphen that is not part of the spelling of a word but is used only to divide the word onto two 
lines. (A hard hyphen, in contrast, is part of the word's spelling and is therefore always used.) The Spelling 
checker generates hyphenation points by using pattern-matching technology (rather than retrieving stored 
hyphenation points from a database) to ensure that soft hyphens divide words correctly into syllables, as in the 
following example:

Entry The musician who played the last piano concerto is a child pro-
digy.

Compound The musician who played the last piano concerto is a child prod-
igy.

Hyphenation-dependent spelling errors (Germanic languages)
The use of a soft hyphen to divide a word onto two lines sometimes results in spelling changes in Dutch and 
German. For example, when a German compound formed by linking two or more words would contain the same 
consonant three times in succession, the third consonant is omitted if the letter immediately following it is a 
vowel and the compound appears on one line. However, when such a compound is divided by an end-of-line 
hyphen at the point where the compound words are joined, German spelling rules mandate a spelling change: 
the word is then spelled with all three consonants. 
In addition, when words containing certain combinations of letters (such as ck in the German word backen) are 
divided by soft hyphens, their spelling may change (backen becomes bak-ken).



The Spelling checker detects and corrects errors in these two types of hyphenation-dependent spelling changes 
as shown below:
Languag Word Error Correction

Dutch speculatieïnstellin speculatie-ïnstelling speculatie-instelling

autootje autoo-tje auto-tje
German Schiffahrt Schif-fahrt Schiff-fahrt

Glocken Gloc-ken Glok-ken

Spelling errors
The spelling checker corrects the following types of spelling errors:

Abbreviation errors
Error Correction

English O.C.R. OCR
German us.w. usw.
Spanish Sr Sr.
Portugue Ltda Ltda.

Apostrophe errors
Error Correction

English wo’nt won’t

Cognitive misspellings
These occur when the writer does not know the standard spelling of a word. Cognitive misspellings may be 
phonetic, such as seekwell for sequel in English or étudiet for étudié in French, or they may be morphological 
(wrong ending attached to a stem). The Spelling checker corrects language-specific, cognitive misspellings such 
as the following:

Error Correction
English effishent efficient
French émisfere hémisphère 

achetrice acheteuse
German Säson Saison 

Filosofie Philosophie 
Kinden Kindern

Portugue cabeleirero cabeleireiro

atráz atrás
Spanish peremne perenne

lagrimógeno lacrimógeno

Open vs. closed spelling errors
Error Correction

Dutch dank zij dankzij
English anyone of any one of
French avoir à faire à avoir affaire à
German ab zu sein abzusein

abist ab ist
Portugue rosa claro rosa-claro



alto relevo alto-relevo
pré-concebido preconcebido

Spanish al pormenor al por menor

Typographic errors
These are the most common variety of spelling errors. In typed text, most misspellings result from errors such as
transposing characters (hte instead of the), pressing the wrong key, inserting an unnecessary character, or 
omitting a character. The Spelling checker corrects typographic errors in all supported languages. It handles 
errors of transposition, substitution, insertion, and omission regardless of their position in a word. The Spelling 
checker’s correction technology enables it to correct words that contain multiple errors and words that start with 
the wrong letter or letters. For example 

Error Correction
English hsa has

unessecery unnecessary
dvantage advantage

French prnd prend 
kivre ivre 

German bneutzt benutzt 
rurmstichig wurmstichig
geraschvlol geräuschvoll 

Portugue mieo meio

caresentar acrescentar 
Spanish msi mis

ortogáfico ortográfico
auotmático automático 

Personal Dictionary
To check the spelling in your document, the spelling checker compares each word in the document with the 
words in the database and returns an error message when a word is not found there. For users who want to save 
specialized terms that are not in the database, the Spelling checker provides the Personal Dictionary. If you 
select a personal database before or during proofreading, the Spelling checker compares each word in your 
document with the words in that personal database. If the word is found in the personal database or Spelling 
checker database, the Spelling checker accepts the word as correctly spelled.
The Spelling checker’s Personal Dictionary component also allows you to do the following:
· Add words to a personal database.
· Specify whether a given personal database should be opened for the current language only or for all 

languages.



Advanced Spelling Options

Language and dialect options
The Spelling checker includes rules, error messages, and descriptions specific to each dialect of English

 U.S. and UK and Portuguese 

 European and Brazilian.

Rule language
For all languages except Portuguese, and Spanish, you can display the descriptions of rule types in either the 
current language or in US English.

Error language
For all languages except Portuguese and Spanish, you can display error messages in either the current language 
or in US English.

Spelling correction options
For each language that you initialize, you can specify whether you want the spelling checker to retrieve and 
display all possible corrections for words not found in the spelling database. You can also specify whether you 
want the Spelling checker to compare each word in your document with the words in any initialized personal 
databases during proofreading. If the word is found in the personal database, the Spelling checker accepts the 
word as correctly spelled (unless the word has been assigned a negative flag).

Maximum sentence elements
You can set the maximum number of sentence elements for each language that you initialize. Sentence 
elements are words or punctuation that the spelling checker treats as units. The default setting for each 
language should be acceptable for most text; you should not change the default unless you need to reduce the 
memory overhead required by the buffer-processing function. 

Language-specific options
You can choose options that customize the Spelling checker’s processing to reflect your preferences for specific 
languages.



How to



Create projects



To use the Create wizard

1. Click the Key button  on the Toolbox.
2. Click the New Project button on the Key page of the Notebook.

Note
· This wizard starts a new project.
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To use the Color, Line, Shadow, and Text Style wizards
1. Select a text or graphic object.
2. Click the appropriate button on the Property Bar to open its dialog box.

3. Click the Key button  in the bottom right corner of the dialog box.

Notes
· The Key button in the Coloring, Line, Shadow, and Text Style dialog boxes open the associated wizard.
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To use the Save wizard

1. Click the Key button  on the Toolbox.
2. Click the Save Project button on the Key page of the Notebook.

Note
· This wizard can also be accessed by clicking the Key button in the Save dialog box.
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To use the Print wizard

1. Click the Key button  on the Toolbox.
2. Click the Print Project button on the Key page of the Notebook.

Note
· This wizard can also be accessed by clicking the Key button in the Print dialog box.
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To use the Open wizard

1. Click the Key button  on the Toolbox.
2. Click the Open Project button on the Key page of the Notebook.

Note
· This wizard can also be accessed    by clicking the Key button in the Open dialog box.
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To use the Namelist wizard
· Click Tools, Create/Edit Namelist.

Notes
· You can use the Namelist wizard to create a new Namelist, edit an existing Namelist, or import data from 

another application to create a Namelist.
· To merge data from a Namelist with your project, you must add Namelist fields to your project and enable the 

Use Namelist check box in the Print dialog box.
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To start a new blank project
· Click File, New.

Notes
· This method starts a new project of the same type. To choose a new project type, use the New Project 

command from the File menu.
· If you are currently working on a file that has not been saved since it was changed, a message box appears 

asking you if you want to save changes to your file. Click Save to save the file. Click No to abandon any 
changes. Click Cancel if you don’t want to start a new project.
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To start a new project
· Click File, New Project.

Notes
· This method launches the Create wizard.
· If you are currently working on a file that has not been saved since it was changed, a message box appears 

asking you if you want to save changes to your file. Click Save to save the file. Click No to abandon any 
changes. Click Cancel if you don’t want to start a new project.
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To return to a standard 8.5" x 11" page layout

1. Click the Key tool .
2. Click File, New.
3. Click File, Page Setup.
4. Type "8.5" in the Width box.
5. Type "11" in the Height box
6. Enable the Portrait button.
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To launch Corel Photo House from within Corel Print House

1. Click the Pick tool .
2. Right-click the photo or bitmap you want to edit in Corel Print House and choose Send To Photo House from
the menu.

 Tip
· You can also double-click the bitmap image to launch Corel Photo House.
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To create a T-shirt design
1. Click File, New Project.
2. Enable the Start From Scratch option, and create a sign project in the appropriate size for your T-shirt design.
3. When the project is complete, click Edit, Select All.
4. Click Arrange, Group.
5. Click Arrange, Flip Horizontally.

You can now print the project on transfer paper and begin wearing your latest Corel Print House design!

 Tip
· If you want to create a small T-shirt logo, choose Custom when you are asked to select a size for your sign. 

When you click Next, the Custom Size dialog box opens and you can type in values.
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To create a photo album page
1. In the Create wizard, use Start from Scratch to create a sign project.
2. Choose a 8.5" by 11" size and enable the Portrait orientation button.
3. Click Notebook, Catalog, Photos.
4. Double-click the Borders category.
5. Scroll through the photos to the Photographic Borders.
6. Double-click the design you prefer.
7. Import the photos you want to add to the page.

If the photos need to be resized or retouched, send them to Corel Photo House. Resizing the photos in Corel 
Print House may distort them.

8. Click Notebook, Styles, Shape Styles.
9. Click Bitmap Shapes.
10. Find a shape that matches the cutouts in your photographic border and drag it to your photos.

Notes
· The Floral Photographic Border is best suited to a landscape orientation.
· You may need to resize your photos after you apply the shapes to make them fit the openings in the 

photographic border.

 Tip
· Apply the Vignette effect to your photos in Corel Photo House before placing them on the photographic border.
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To access help from a dialog box

· Click the Question Mark button  in the lower right corner of the dialog box.

Note

· Some dialog boxes also have a Key button  that launches the wizard associated with the dialog 
box.
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To access a wizard from a dialog box

· Click the Key button  in the lower right corner of the dialog box.

Note

· Many dialog boxes also have a Question Mark button  to access the online Help.
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Save and open your work



To save a new project
1. Click File, Save.
2. Choose a drive and folder where you want to save your project in the Save In list box.
3. Type a name in the File Name box.
4. Click Save.

Note
· All Corel Print House files are saved with the .CPH file extension. This allows you to double-click a saved file in 

the Windows Explorer and launch Corel Print House.

 Tip 

· For step-by-step instructions for saving your project, click the Key button  in the Save dialog box 
to launch the Save wizard.
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To save your project under a new name
1. Click File, Save As.
2. Choose a drive and folder where you want to save your project in the Save In list box, .
3. Type a new name in the File Name box.
4. Click Save.

Note

· For step-by-step instructions for saving your project, click the Key button  in the Save dialog box 
to launch the Save wizard.
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To open a file
1. Click File, Open.
2. Choose the drive where the file is stored in the Look In list box.
3. Double-click the folder where the file is stored.
4. Double-click the project’s filename.

Notes
· If you try to open a project that is already open, a message box appears asking you if you want to revert to the

saved version of the project. Click Yes to replace the open project with the saved version. Click No to keep the 
open project in its current state.

· You can open a recently saved file by clicking its name at the bottom of the File menu.
· You can use wild cards (* and ?) if you're not sure of the name of the file you want to open. For example, 

typing "TEST*.CPH" in the File Name box lists all.CPH files in the selected directory beginning with test. Typing 
"TEST?.CPH" in the File Name box lists all.CPH files in the selected directory that begin with test and are 
followed by one character (TEST1.CPH).

 Tip

· For step-by-step instructions for opening files, click the Key button  in the Open dialog box to 
launch the Open wizard.
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To import a file
1. Click File, Import.
2. Choose an import format from the Files Of Type box.

The File Name box shows files in the current folder with the chosen format's extension. If the file you want is in
another drive or folder, select the drive from the Look In box and the folder from the Folders box.

3. In the File Name box, type the name of the file you want to import.

Note
· If you want to import a text file into the Namelist, click Tools, Create/Edit Namelist.
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To export a Corel Print House file
1. Click File, Save As.
2. Choose the drive and folder where you want to store the exported file in the Save In box,.
3. Choose a file format from the Save As type box,.
4. Type a filename in the File Name box.

Note
· Depending on the file format you choose, additional dialog boxes may appear when you click Save.
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To mail a project
1. Click File, Send Mail.
2. Follow the instructions provided by Microsoft Exchange.
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Change the view of your work



To zoom out
· Click View, Zoom, Full Page.

Note

· You can also zoom out by clicking the Zoom out button  on the Standard toolbar.
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To zoom in on an object

1. Click the Pick tool 
2. Click the object.
3. Click View, Zoom, To Selected.

Note

· You can also zoom in on part of your project by clicking the Zoom button  on the Standard toolbar and 
marquee selecting the area.
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To view the entire page
· Click View, Zoom, Full Page.
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To view the previous page
· Click View, Previous Page.

Notes
· You can only view the previous page if you have a multi-page document.
· You can also flip to the previous page by using the Page Flipper at the bottom of the Toolbox.
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To view the next page
· Click View, Next Page.

Notes
· You can only view the next page if you have a multi-page document.
· You can also flip to the next page by using the Page Flipper at the bottom of the Toolbox.
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Change the display of your work



To display your work in full color
· Click View, Full Color
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To display your work as a coloring book
· Click View, Coloring Book
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To display your work in grayscale
· Click View, Grayscale.
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Use catalog objects



To use Corel Print House Clipart, borders, backdrops, or photos in other 
applications
1. Launch the other application.
2. Launch Corel Print House.
3. Click Notebook, Catalog, and choose the type of item you want from the menu.
4. Double-click the item you want in the Notebook.

5. Click the Pick tool .
6. Click the object.
7. Click Edit, Cut or Copy.
8. Click in the other application.
9. Click Edit, Paste.

Depending on your application, you may have to use the Paste Special option for photos and paste them as 
Device-Independent bitmaps.

Note
· If your application supports.CMX format, you can import Clipart and border files directly from the CD-ROM, 

without cutting and pasting them from Corel Print House. If your application supports.JPG (JPEG) format, you 
can import photos directly from the CD-ROM.
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To place a Clipart object
1. Click Notebook, Catalog, Clipart.
2. Double-click a Clipart category.

You may need to repeat this step if the category you choose has subcategories.
3. Double-click the graphic.

Notes
· A Clipart graphic is made up of a group of objects. To ungroup a Clipart graphic so you can edit it, click 

Arrange, Ungroup.
· The Go Back button returns you to the previous Notebook page. The arrows scroll you through the Clipart 

graphics.
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To edit a Clipart object

1. Click the Pick tool .
2. Click the Clipart object.
3. Click Arrange, Ungroup.

You may need to repeat this step if the Clipart is made up of subgroups
4. Click on an empty place on your page to deselect all objects.
5. Click the individual line or graphic object in the Clipart you wish to edit.

Notes
· You can edit the Clipart in many ways including changing the color, shape, or size of individual graphic objects 

and lines.
· Some cards use bitmap graphics on their front page. These graphics cannot be edited using this procedure but

can be edited using Corel Photo House.
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To place a backdrop object
1. Click Notebook, Catalog, Backdrops.
2. Double-click a backdrop category.

You may need to repeat this step if the category you choose has subcategories.
3. Double-click the backdrop.
4. Follow the instructions in the Backdrop Import dialog box for placing your backdrop.

Notes
· When a backdrop is placed on your page, it is fixed in place and cannot be moved or edited. To merge a 

backdrop to your page so you can move or edit it, click Tools, Merge Backdrop. Once a backdrop has been 
merged it can be edited.

· The Go Back button returns you to the previous Notebook page. The arrows scroll you through the different 
backdrops.
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To edit a backdrop object
1. Click Tools, Merge Backdrop.
2. Click Arrange, Ungroup.
3. Select the portion of the backdrop you wish to edit.

Note
· You cannot edit a backdrop that has not been merged with your project.
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To delete a backdrop object
· Click Tools, Delete Backdrop.
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To place a border object
1. Click Notebook, Catalog, Borders.
2. Double-click a border category.

You may need to repeat this step if the category you choose has subcategories.
3. Double-click the border.
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To resize a border object

1. Select the border with the Shaper tool .
2. Drag a node to increase or decrease the size of the border object.

{button ,AL(`Use catalog objects;',0,"Defaultoverview",)} Related Topics



To place a phrase
1. Click Notebook, Catalog, Phrases.
2. Double-click a phrase category.

You may need to repeat this step if the category you choose has subcategories.
3. Double-click the front or inside portion of the phrase.

Note
· The Go Back button returns you to the previous Notebook page. The arrows scroll you through the numerous 

phrases.
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To place a photograph
1. Click Notebook, Catalog, Photos.
2. Double-click a photo category.

You may need to repeat this step if the category you choose has subcategories.
3. Double-click the photo.

Note
· The Go Back button returns you to the previous Notebook page. The arrows scroll you through the numerous 

photographs.
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To change the shape of a photo

1. Click the Pick tool .
2. Click the photo.
3. Click Tools, Add Shape.

Node-edit handles appear at the corners of the photo.
4. Drag the handles to change the shape of the outline.

Note
· Changing the photo’s outline has no effect on the photo. Rather, Corel Print House displays only the area of 

the bitmap that appears within the outline.

 Tips
· Click the right mouse button to access node-editing commands.
· Hold down CTRL while you drag a node to allow only horizontal or vertical movement.
· You can also change the shape of a photo by applying a shape style from the Notebook.
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To add an item to the Scrapbook
1. Click Notebook, Catalog, Scrapbook.
2. Drag the item from your page to the Scrapbook window in the Notebook.

Note
· If you drag multiple objects to the Scrapbook, group them first. Ungrouped objects are added to the Scrapbook

as separate objects.

 Tip
· You can also drag items out of the Scrapbook.
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To use a Scrapbook item
1. Click Notebook, Catalog, Scrapbook.
2. Double-click the item

 Tip
· You can also drag items out of the Scrapbook.
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To delete a Scrapbook item
1. Click Notebook, Catalog, Scrapbook.
2. Right-click the Scrapbook item and choose Delete from the menu.
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Create graphic objects



To draw a freehand graphic object

1. Click the Freehand tool .
2. Click and drag to create a line or shape.

Note
· To erase part of the path you have drawn, hold down SHIFT while continuing to drag backwards. When you 

release SHIFT, you can resume drawing your line.
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To connect two freehand graphic objects

1. Click the Pick tool .
2. Hold down SHIFT and click the two freehand graphic objects.
3. Click Arrange, Combine.

4. Click the Shaper tool .
5. Hold down SHIFT and click one node from each freehand graphic object.
6. Right-click and choose Join from the menu.
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To draw a straight line

1. Click the Freehand tool .
2. Click where you want the line to begin.
3. Click where you want the line to end.

Note
· To draw another line connected to the first, click the endpoint of the last line and continue drawing. You can 

streamline this action by double-clicking to finish each line segment and start the next. Remember to click, not
double-click, when you finish the final segment. To connect the line segments, you must click within five pixels 
of the endpoint.

 Tip
· Hold down CTRL as you draw the line to constrain it to 15-degree increments.
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To draw a square

1. Click the Rectangle tool .
2. Position the cursor where you want one corner of the square to appear.
3. Hold down CTRL and click and drag the cursor up or down and off to one side.

The CTRL key constrains the rectangle to a square.

 Tip
· Hold down SHIFT and CTRL to draw a square from the center.
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To draw a rectangle

1. Click the Rectangle tool .
2. Position the cursor where you want one corner of the rectangle to appear.
3. Click and drag the cursor up or down and off to one side.

 Tip
· Hold down SHIFT while dragging to draw the rectangle from the center.
· Hold down CTRL while dragging to draw a square.
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To draw a circle

1. Click the Ellipse tool .
2. Position the cursor where you want one corner of the circle's highlighting box to appear.
3. Hold down CTRL and click and drag the cursor up or down and off to one side.

The CTRL key constrains the ellipse to a circle.

 Tip
· Hold down SHIFT+CTRL to draw a circle from the center.
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To draw an ellipse

1. Click the Ellipse tool .
2. Position the cursor where you want one corner of the ellipse's highlighting box to appear.
3. Click and drag the cursor up or down and off to one side.

 Tip
· Hold down SHIFT while dragging to draw the ellipse from the center.
· Hold down CTRL while dragging to draw a circle.
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To draw a polygon

1. Click the Polygon tool .
2. Click the Polygon Sides button on the Property Bar.
3. Type the number of sides in the Number Of Sides box.
4. Click OK.
5. Position the cursor where you want one corner of the polygon to appear.
6. Click and drag the cursor up or down and off to one side.

Note
· A five-sided polygon is the default shape.
· You can change the number of sides of a polygon by clicking the Polygon Sides button on the Property Bar 

after the graphic object is drawn.

 Tips
· Hold down SHIFT while dragging to draw the polygon from the center.
· Hold down CTRL while dragging to create a polygon of equal width and height.
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To draw a star

1. Click the Polygon tool .
2. Click the Polygon Sides button on the Property Bar.
3. Type the number of sides in the Number Of Sides box.
4. Click OK.
5. Position the cursor where you want one corner of the object to appear.
6. Click and drag the cursor up or down and off to one side.

7. Select the object you just created with the Shaper tool .
8. Drag one of the nodes towards the center of the object to create a star shape.

Note
· You can change the number of sides of a polygon or star by clicking the Polygon Sides button on the Property 

Bar after the graphic object is drawn.

 Tip
· Double-clicking any graphic object activates the Shaper tool and allows you to begin node editing.
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Add text



To add Artistic text

1. Click the Text tool .
2. Click anywhere in the Document Window.
3. Type the text.

Notes
· Once the text is on the page, you can use the Text Attributes button to change the font, point size, and other 

character attributes. 
· You can also change character attributes by using the Text toolbar.
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To fit Artistic text to a path

1. Click the Pick tool .
2. Click the text object.
3. Hold down SHIFT and click the line or graphic object.
4. Click Tools, Fit Text To Path.
5. Do any of the following:
· Click an Orientation button.
· Click a vertical alignment button.
· Click Side button.
· Type a value in the Horizontal Offset box to position the text along the line or graphic object.
· Type a value in the Distance From Path box to position the text above or below the line or graphic object.
· Enable the Place Text On Inside check box to flip the text to the opposite side of the path and reverse the start 

and end points.

Note
· Once the text has been fit to the path, you can delete the line or graphic object so that only the text remains.
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To straighten Artistic text that has been fit to a path

1. Click the Pick tool .
2. Right-click the text object and click Straighten from the menu.
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To place Paragraph text

1. Click the Text tool .
2. Drag the cursor to draw a Paragraph text frame to the size you require.

When you release the mouse button the text cursor appears at the top of the frame.
3. Type text into the frame.

Note
· You can resize Paragraph text frames without affecting the point size of the text.
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To select text

1. Click the Text tool .
2. Select the text using one of the following methods:
· To select a word, double-click it.
· To select a group of letters or words, drag the mouse across them.

Notes
· Once the text is selected, you can type new text to replace it, or use the Cut, Copy, and Paste commands from 

the Edit menu.
· You can also change the selected text's font, point size, color, and other attributes.
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To change existing text

1. Click the Text tool .
2. Select the text you wish to change.
3. Type the new text.

Note
· To insert new text without replacing any existing text, insert the cursor in the text line and begin typing.
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To change text style
1. Click Notebook, Styles, Text Style.
2. Drag a font style from the Notebook onto the text you want to change.

Note
· You can change font attributes by selecting the text and clicking the Text Attributes button on the Property Bar.

 Tips
· You can add your own custom text styles to the Notebook by dragging them from your page to the Notebook.

· To use the Text Style wizard, click the Key button  in the lower right corner of the Text Style 
dialog box.
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To copy an object's text style to another object
1. Select the text object whose style you want to copy.
2. Click the Styles tab in the Notebook.
3. Choose Text.
4. Drag the text object to the Notebook.
5. Drag the created text style from the Notebook to the new text object.
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To check the spelling in your project
· Click Tools, Spelling.

Note
· In the Spelling dialog box, errors are reported and suggestions are given. You can change any misspelled 

words, ignore the error, or add new words to the dictionary.

 Tip
· Add frequently used words such as your name, your street name, and your postal/zip code to the dictionary.
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To change the spell check language
1. Click Tools, Spelling.
2. Click Options, Advanced Options.
3. Choose a language from the Language Name box.
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Use Namelists



To add fields from a Namelist to your project

1. Click the Pick tool .
2. Click the text that the Namelist field will replace.
3. Click Tools, Use Namelist Fields.
4. Click the Namelist you want to use.
5. Click the Namelist field you want to use.

Note
· After the fields have been added to your project, enable the Use Namelist check box in the Print dialog box to 

automatically replace the field names with the appropriate data from the Namelist.
· To replace only part of a text object (e.g., if you have a text object that says "Dear Sir", and you want to 

replace the word "Sir"), you must use the Break Apart command on the Arrange menu to break the text object 
into separate words. Then, select the text object that says "Sir", and right-click to replace it with a Namelist 
field.

 Tips
· Ensure that you leave enough room to accommodate Namelist records of any length. For example, if you are 

adding people's names to a project, make sure there is enough space in your design for the longest name in 
your Namelist.

· You can also right-click inside an empty Paragraph text box and choose Insert Field from the menu to insert a 
Namelist field in your project.

· Instead of using the Tools menu, you can also right-click the text object and click Replace With Field from the 
menu.

{button ,AL(`PRC Namelist;',0,"Defaultoverview",)} Related Topics



To import data into a Namelist
· Click Tools, Create/Edit Namelist.

Notes
· Data must be in Tab Separated format. A Tab Separated file is an ASCII text file consisting of a series of data 

fields separated by the tab character. A record consists of multiple fields ending with a hard return. The first 
row of data must be the field names or headings.

· To merge data from a Namelist with your project, you must add Namelist fields to your project and enable the 
Use Namelist check box in the Print dialog box.
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To create data in the Tab Separated format
1. Open a text editor such as Notepad, a word processing package such as Corel WordPerfect, or a spreadsheet 

package such as Corel Quattro Pro.
2. Enter your data in Tab Separated format.
3. Save the file as a Text document (.TXT).

In Corel WordPerfect, choose the ASCII DOS Generic Word Processor (.TXT) format.
In Corel Quattro Pro, choose the Text (.TXT) format.

Notes
· A Tab Separated file is an ASCII text file consisting of a series of data fields separated by the Tab character. A 

record consists of multiple fields ending with a hard return.
· Corel Print House uses the first row of data as the Namelist field names.
· In Notepad, a file can only be saved as a text document.
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Create tables



To draw a table

1. Click the Table tool .
2. Position the cursor where you want one corner of the table to appear.
3. Click and drag the cursor up or down and off to one side.

Notes
· The default setting is four rows and three columns.
· You can edit the table by clicking the Resize Rows/Columns and the Number Of Rows/Columns buttons on the 

Property Bar.

 Tip
· Hold down SHIFT while dragging to draw the table from the center.
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To add a row to a table

1. Click the Table tool .
2. Click a cell in the table.
3. Click Tools, Insert Rows/Columns.
4. Enable the Row(s) button.
5. Type a value in the # Of Rows/Columns box.
6. Choose to insert the row before or after the selected row by enabling one of the Options buttons.

Note
· You can also change the number of rows and columns by clicking the Number Of Rows/Columns button on the 

Property Bar.
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To add a column to a table

1. Click the Table tool .
2. Click a cell in the table.
3. Click Tools, Insert Rows/Columns.
4. Enable the Column(s) button.
5. Type a value in the # Of Rows/Columns box.
6. Choose to insert the column before or after the selected column by enabling one of the Options buttons.

Note
· You can also change the number of rows and columns by clicking the Number of Rows/Columns button on the 

Property Bar.
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To delete a row from a table

1. Click the Table tool .
2. Click a cell in the row you want to delete.
3. Click Tools, Delete Rows/Columns.
4. Enable the Row button.

Notes
· The row in which the selected cell resides is deleted.
· You can also change the number of rows and columns by clicking the Number Of Rows/Columns button on the 

Property Bar.
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To delete a column from a table

1. Click the Table tool .
2. Click a cell in the row you want to delete.
3. Click Tools, Delete Rows/Columns.
4. Enable the Column button.

Notes
· The column in which the selected cell resides is deleted.
· You can also change the number of rows and columns by clicking the Number Of Rows/Columns button on the 

Property Bar.
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To resize a table cell

1. Click the Table tool .
2. Click the cell you want to resize.
3. Click the Resize Rows/Columns button on the Property Bar.
4. Type a new cell height and/or cell width in the appropriate boxes.

Increasing cell height affects the height of all cells in the row. Increasing cell width affects the width of all cells 
in the column.
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Select objects



To select an object

1. Click the Pick tool .
2. Click anywhere on a filled object or anywhere on an unfilled object's outline.

 Tip
· Selecting thin lines or small objects using this method can be difficult. Try to marquee select these objects 

instead.
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To select multiple objects

1. Click the Pick tool .
2. Hold down SHIFT and click the objects.

Notes
· You can click anywhere on a filled object or anywhere on an unfilled object's outline.
· Selecting more than one object lets you apply the same commands, transformations, or attributes to all of 

them. When you select multiple objects, a single highlighting box encloses all of them.
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To marquee select objects

1. Click the Pick tool .
2. Hold down the mouse button and drag the marquee box until it completely encloses the objects you want 
selected.

Notes
· Selecting more than one object lets you apply the same commands, transformations, or attributes to them. 

When you select multiple objects, a single highlighting box encloses all of them.
· If you hold down ALT, all the objects that touch the marquee box are also selected.
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To select all objects
· Click Edit, Select All.

Note
· Selecting more than one object lets you apply the same commands, transformations, or attributes to all of 

them. When you select multiple objects, a single highlighting box encloses all of them .
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To deselect an object from several selected objects

1. Click the Pick tool .
2. Hold down SHIFT and click anywhere on a filled object or anywhere on an unfilled object's outline.
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To deselect all objects
· Click any open space in the Drawing Window.
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Select groups



To select a group of objects

1. Click the Pick tool .
2. Click an object that is included in the group.

Notes
· Click anywhere on a filled object or anywhere on an unfilled object's outline.
· When you select a group, a single highlighting box encloses all of the objects in the group.
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To marquee select a group of objects

1. Click the Pick tool .
2. Hold down the mouse button and drag the marquee box until it completely encloses all the objects in the 
group.

Notes
· When you select a group, a single highlighting box encloses all of the objects in the group.
· If you hold down ALT, all the groups that touch the marquee box are also selected.
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To select multiple groups

1.  Click the Pick tool .
2. Hold down SHIFT and click an object in each group.

Notes
· You can also drag a marquee box around all objects in the groups to select them.
· When you select multiple groups, a single highlighting box encloses all groups.
· If you hold down ALT, all the groups that touch the marquee box are also selected.
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To select an object from within a group of objects

1. Click the Pick tool .
2. Hold down CTRL and click the object until its highlighting box appears.

Note
· The handles of the object appear as red circles to denote that it is part of a group.
· If the object is in a subgroup which is part of a larger group, you may need to click the object more than once 

to highlight it. The first click highlights the largest subgroup the object is part of. Each successive click 
highlights a smaller subgroup, until you have highlighted the object itself.
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Group and combine objects



To group objects

1. Click the Pick tool .
2. Hold down SHIFT and click the objects you want to group.
3. Click Arrange, Group.
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To ungroup objects

1. Click the Pick tool .
2. Click any object in the group.
3. Click Arrange, Ungroup.

 Tip
· If you have grouped together two or more groups, click Arrange, Ungroup to ungroup one level at time.
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To select individual objects in a group

1. Click the Pick tool .
2. Hold down CTRL and click on the object you want.

Note
· Notice the handles on the object’s highlighting box are round rather than square; this indicates that you have 

selected an object which is part of a group of objects.
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To select an object in a nested group

1. Click the Pick tool .
2. Hold down CTRL and click the object until its highlighting box appears.

Note
· Notice the handles on the object’s highlighting box are round rather than square; this indicates that you have 

selected an object which is part of a group of objects.
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To combine objects

1. Click the Pick tool .
2. Hold down SHIFT and click the objects you want to combine.
3. Click Arrange, Combine.
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To separate combined objects

1. Click the Pick tool .
2. Click the combined object.
3. Click Arrange, Break Apart.

Notes
· Using the Break Apart command on a single word of Artistic text breaks it into separate characters; using the 

Break Apart command on multiple words of Artistic text breaks each word into a separate text object.
· When you break apart objects, they remain curve objects regardless of what they were before they were 

combined. The only exception is Artistic text, which can be broken apart without being combined first.
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Move, copy, and delete objects



To position an object on the page

1. Click the Pick tool .
2. Click the object.

3. Click the Position button  on the Property Bar.
4. Type values in the Horizontal and Vertical boxes.

Note
· You can move an object using the mouse by selecting the object and dragging it to a new location.
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To move an object using the mouse

1. Click the Pick tool .
2. Drag the object to a new location.

Note
· You can also use the Arrow keys to move objects.
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To duplicate an object

1. Click the Pick tool .
2. Click the object (or group of objects) you want to duplicate.
3. Click Edit, Duplicate.

Note
· Corel Print House offsets the copied object slightly from the original. The default offset is 0.10 inches. You can 

change this value in the Options dialog box (in the Tools menu) by clicking the Edit tab and changing the 
values in Place Duplicates.
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To constrain an object's movement

1. Click the Pick tool .
2. Click the object (or group of objects) you want to move.
3. Hold down CTRL and drag the object to a new location.

Holding down CTRL forces the object(s) to move horizontally or vertically.
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To move an object in increments

1. Click the Pick tool .
2. Click the object (or group of objects) you want to move.
3. Press an Arrow key to move the object up, down, left, or right.

Notes
· Holding down an Arrow key moves the object in continuous steps. The default amount is 0.10 inches.
· You can change the default setting in the Options dialog box (in the Tools menu) by clicking the Edit tab and 

changing the value in the Nudge box.
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To copy and paste an object

1. Click the Pick tool .
2. Click the object (or group of objects) you want to copy.
3. Click Edit, Copy.
4. Open the Corel Print House file into which you want to paste the object.
5. Click Edit, Paste.

Note
· The object remains on the Clipboard until you cut or copy another object onto it from Corel Print House or from

another Windows application.
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To cut and paste an object

1. Click the Pick tool .
2. Select the object.
3. Click Edit, Cut.
4. Open the Corel Print House file into which you want to paste the object.
5. Click Edit, Paste.

Note
· The object remains on the Clipboard until you cut or copy another object onto it from Corel Print House or from

another Windows application.
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To delete an object

1. Click the Pick tool .
2. Click the object.
3. Click Edit, Delete.

Notes
· You can retrieve a deleted object by clicking Edit, Undo as long as you retrieve the object within the number of

undo levels specified in the Options dialog box.
· You should not confuse the Delete command with the Cut command. The Cut command removes the object 

and places it on the Clipboard allowing you to paste it back into the project. The Delete command deletes the 
object without placing it on the Clipboard.

· Pressing DELETE also deletes objects.
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Size, rotate, shadow, and skew objects



To change the size of an object

1. Click the Pick tool .
2. Click the object.
3. Click the Size button on the Property Bar.
4. Type values in the Horizontal and Vertical boxes.

Note
· You can also size an object using the mouse by selecting the object and dragging one of the corner handles.
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To stretch an object

1. Click the Pick tool 
2. Click the object.
3. Do one of the following:
· Drag one of the side handles to stretch the object.
· Drag one of the corner handles to scale the object.

Note
· Stretching an object changes its width to height ratio (also called the aspect ratio). Scaling an object maintains

its width to height ratio.
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To rotate an object

1. Click the Pick tool 
2. Click the object twice.

The handles on the object's highlighting box appear as two-way arrows.
3. Drag one of the corner arrows in a circular motion to attain the desired rotation.

Notes
· If the object is unfilled, click its outline to select it.
· By default, an object rotates around a point (called the center of rotation) in the middle of its highlighting box. 

To change the center of rotation, drag the center of rotation marker to the desired location. 
· You can rotate an object in 90-degree increments from the Arrange, Rotate menu.

 Tip
· Hold down CTRL while dragging to force the object to rotate in 15-degree increments.
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To skew an object

1. Click the Pick tool 
2. Click the object twice.

The handles on the object's highlighting box appear as two-way arrows.
3. Drag one of the side arrows to skew the object.

Note
· If the object has no fill, double-click its outline to see its two-way arrows.

 Tip
· Hold down CTRL to constrain the object's movement to 15-degree increments when skewing with the mouse.
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To add a shadow to an object

1. Click the Pick tool 
2. Click the object.
3. Click the Shadows button on the Property Bar.
4. Type values in the Shadows, Length, Angle, Scale, and Skew boxes.
5. Drag the rectangular indicator in the Preview window to set the direction of the shadow.
6. Choose the color of the shadow by clicking the Last Shadow button.

If you have entered a value of 2 or more in the Shadows box, you can also choose the color of the first shadow 
by clicking the First Shadow button.

Note
· You can use predefined shadow styles from the Styles page in the Notebook by dragging them onto your 

object. You can add your own custom shadow styles to the Notebook by dragging them from your page to the 
Notebook.
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To delete a shadow from an object

1. Click the Pick tool 
2. Click the object.
3. Click the Shadows button on the Property Bar.
4. Type "0"In the Shadows box.
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Change the outline of objects



To create a dashed line

1. Click the Pick tool 
2. Click the object.
3. Click the Line button on the Property Bar.
4. Click the Style tab.
5. Choose a dashed style from the Dash list box.

Notes
· You can use predefined line styles from the Styles page in the Notebook by dragging them onto your object. 

You can add your own custom line styles to the Notebook by dragging them from your page to the Notebook.

 Tip
· For step-by-step instructions for creating lines, click the Key button in the Line dialog box to launch the Line 

wizard.
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To create a dotted line or a line with rounded line segments

1. Click the Pick tool 
2. Click the object.
3. Click the Line button on the Property Bar.
4. Click the Style tab.
5. Choose a dashed or dotted style from the Dash list box.

For a dotted line, choose a style with short, widely spaced segments.
6. Enable the Rounded Line Caps button.

Notes
· You can use predefined line styles from the Styles page in the Notebook by dragging them onto your object. 

You can add your own custom line styles to the Notebook by dragging them from your page to the Notebook.

 Tip
· For step-by-step instructions for creating lines, click the Key button in the Line dialog box to launch the Line 

wizard.
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To set an object's corner shape

1. Click the Pick tool 
2. Click the object.
3. Click the Line button on the Property Bar.
4. Click the Style tab.
5. Enable a Corners button.

Notes
· You can use predefined line styles from the Styles page in the Notebook by dragging them onto your object. 

You can add your own custom line styles to the Notebook by dragging them from your page to the Notebook.

 Tip
· For step-by-step instructions for creating lines, click the Key button in the Line dialog box to launch the Line 

wizard.
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To set an object's line cap shape

1. Click the Pick tool 
2. Click the object.
3. Click the Line button on the Property Bar.
4. Click the Style tab.
5. Enable a Line Caps option.

Notes
· Square Line Caps cuts the line off exactly at the end points.
· Rounded Line Caps rounds off the ends of the line.
· Extended Square Line Caps squares off the line and extends it beyond the endpoints for a distance equal to 

half the line thickness.

 Tips
· You can use predefined line styles from the Styles page in the Notebook by dragging them onto your object. 

You can add your own custom line styles to the Notebook by dragging them from your page to the Notebook.
· For step-by-step instructions for creating lines, click the Key button in the Line dialog box to launch the Line 

wizard.
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To set a line's arrowheads

1. Click the Pick tool 
2. Click the object.
3. Click the Line button on the Property Bar.
4. Click the Style tab.
5. Choose an arrowhead style for the beginning and the end of line by clicking the Arrows buttons.

Notes
· You can use predefined line styles from the Styles page in the Notebook by dragging them onto your object. 

You can add your own custom line styles to the Notebook by dragging them from your page to the Notebook.

 Tip
· For step-by-step instructions for creating lines, click the Key button in the Line dialog box to launch the Line 

wizard.
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To set outline width

1. Click the Pick tool 
2. Click the object.
3. Click the Line button on the Property Bar.
4. Click the Style tab.
5. Type a width in the Width box.

Notes
· You can use predefined line styles from the Styles page in the Notebook by dragging them onto your object. 

You can add your own custom line styles to the Notebook by dragging them from your page to the Notebook.

 Tip
· For step-by-step instructions for creating lines, click the Key button in the Line dialog box to launch the Line 

wizard.
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To set outline color

1. Click the Pick tool 
2. Click the object.
3. Click the Line button on the Property Bar.
4. Click the Color tab.
5. Click a color in the color picker.

Notes
· You can use predefined line styles from the Styles page in the Notebook by dragging them onto your object. 

You can add your own custom line styles to the Notebook by dragging them from your page to the Notebook.

 Tip
· For step-by-step instructions for creating lines, click the Key button in the Line dialog box to launch the Line 

wizard.
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To copy an object's outline to another object

1. Click the Pick tool 
2. Click the object.
3. Click Notebook, Styles, Line.
4. Drag the object to the Notebook.
5. Drag the new line style from the Notebook onto the other object.
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Change the color of objects



To fill an object with a solid color

1. Click the Pick tool 
2. Click the object.
3. Click the Coloring button on the Property Bar.
4. Click the Solid Fill button.
5. Click a color from the color picker.

Notes
· You can use predefined color styles from the Styles page in the Notebook by dragging them onto your object. 

You can add your own custom color styles to the Notebook by dragging them from your page to the Notebook.

 Tip
· For step-by-step instructions for coloring your object, click the Key button in the Coloring dialog box to launch 

the Coloring wizard.
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To fill an object with a gradient fill

1. Click the Pick tool 
2. Click the object.
3. Click the Coloring button on the Property Bar.
4. Click a Gradient Fill button.
5. Choose a direct fill by clicking the Direct Fill button, or choose a rainbow fill by clicking the Clockwise or 
Counterclockwise Rainbow Fill buttons.
6. Choose start and end colors for the fill by clicking the color buttons.
7. Choose an orientation for the fill by dragging the circular selector in the Preview window.

Notes
· You can use predefined color styles from the Styles page in the Notebook by dragging them onto your object. 

You can add your own custom color styles to the Notebook by dragging them from your page to the Notebook.

 Tip
· For step-by-step instructions for coloring your object, click the Key button in the Coloring dialog box to launch 

the Coloring wizard.
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To change the orientation of a gradient fill

1. Click the Pick tool 
2. Click the object.
3. Click the Coloring button on the Property Bar.
4. Drag the circular selector in the Preview window.

Notes
· You can use predefined color styles from the Styles page in the Notebook by dragging them onto your object. 

You can add your own custom color styles to the Notebook by dragging them from your page to the Notebook.

 Tip
· For step-by-step instructions for coloring your object, click the Key button in the Coloring dialog box to launch 

the Coloring wizard.
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To fade an object

1. Click the Pick tool 
2. Click the object.
3. Click the Fader button on the Property Bar.
4. Drag the slider to the left to make the object darker, or to the right to make the object lighter.

 Tip
· You can fade graphics such as Clipart and photos to create background watermarks.
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To create a custom color

1. Click the Pick tool 
2. Click the object.
3. Click the Coloring button on the Property Bar.
4. Click the More button.
5. Move the indicator in the circular selector to the desired primary color.
6. Move the indicator in the triangular selector to the desired hue.

Notes
· You can use predefined color styles from the Styles page in the Notebook by dragging them onto your object. 

You can add your own custom color styles to the Notebook by dragging them from your page to the Notebook.

 Tip
· For step-by-step instructions for coloring your object, click the Key button in the Coloring dialog box to launch 

the Coloring wizard.
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To remove an object’s fill

1. Click the Pick tool 
2. Click the object.
3. Click the Coloring button on the Property Bar.
4. Click the No Fill button.

Notes
· You can also drag the No Color icon from the Styles page of the Notebook to your object.

 Tip
· For step-by-step instructions for removing an object’s fill, click the Key button in the Coloring dialog box to 

launch the Coloring wizard.
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To copy an object's fill to another object

1. Click the Pick tool 
2. Click the object.
3. Click Notebook, Styles, Coloring.
4. Drag the object to the Notebook.
5. Drag the new coloring style from the Notebook onto the other object.
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Use shapes with objects and photos



To create a shape for an object or photo

1. Click the Pick tool .
2. Click the object or photo.
3. Click Tools, Add Shape.

Eight nodes appear around the object or photo.
4. Drag the nodes to create the desired shape.

 Tip
· For more information about using the nodes to shape your object or photo, see the procedures on changing 

the shape of freehand objects.
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To create a shape from a piece of Clipart

1. Click the Pick tool .
2. Click Notebook, Styles, Shape Styles.
3. Drag the piece of Clipart to the Notebook.

Note
· Some Clipart objects may be too complex to use as shapes and cannot be dragged to the Styles page.
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To add a shape to the Styles page of the Notebook

1. Click the Pick tool .
2. Click the object or photo.
3. Click Tools, Add Shape.

Eight nodes appear around the object or photo.
4. Drag the nodes to create the desired shape.
5. Click Notebook, Styles, Shape Styles.
6. Choose the type of shape you want to add.
7. Drag the object to the Notebook.
8. Right-click the new shape style in the Notebook and click Rename from the menu.
9. Type a name for your shape.

 Tip
· You can also drag graphic objects such as ellipses, polygons, and Clipart into the Notebook to create shapes.
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To add a shape to an object or photo
1. Click Notebook, Styles, Shape Styles.
2. Choose the type of shape you want to use.
3. Drag a shape from the Notebook onto the object or photo.

 Tip
· You can also double-click any shape to apply it to your currently selected object or photo.
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To remove a shape from an object or photo

1. Click the Pick tool .
2. Click the object or photo.
3. Click Tools, Remove Shape.
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Change the shape of rectangles, ellipses, 
and polygons



To round the corners of a rectangle or square

1. Click the Pick tool .
2. Click the object.
3. Click the Corner Roundness button on the Property Bar.
4. Choose the degree of roundness for each corner using the slider.

 Tips
· You can also set the degree of roundness by typing values the Corner Roundness dialog box.
· Another method of rounding the corners of rectangles is to double-click the rectangle and drag the corner 

nodes along the outline of the object.
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To round the corners of a rectangle or square using the Shaper tool

1. Select the rectangle or square with the Shaper tool .
2. Drag one of the corner nodes along the outline of the rectangle or square.

As you drag, the four corner nodes each divide into two nodes with a round corner forming in-between. As you 
continue to drag, the corners become more rounded.

Note
· You can also round the corners of rectangles or squares by using the Corner Roundness button on the Property 

Bar.
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To turn an ellipse or circle into an arc or pie wedge

1. Select the ellipse or circle with the Shaper tool .
2. Drag the node on the ellipse or circle.

As you drag, the node divides into two nodes with the arc or pie wedge forming in-between.
· Keep the mouse inside the ellipse the circle to create an arc.
· Keep the mouse outside the ellipse or circle to create a pie wedge.

Note
· You can also turn an ellipse or a circle into an arc or pie wedge by using the Ellipse/Pie/Arc button on the 

Property Bar.
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To flip an object

1. Click the Pick tool .
2. Click the object.
3. Click Arrange, Flip Vertically or Flip Horizontally.

Notes
· You can flip an object using the mouse by selecting it and dragging the sizing handles completely past the 

outline of the object in either the up/down or left/right direction. This will flip the object either vertically or 
horizontally, but will not retain the object’s size.
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To convert objects to freehand graphic objects

1. Click the Pick tool .
2. Click the object.
3. Click Arrange, Convert To Curves.

Note
· The object looks the same, but it is now a curve object that you can reshape by manipulating its nodes and 

control points with the Shaper tool .
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Change the shape of freehand objects



To select the start or end node of an object

1. Select the curve object with the Shaper tool .
2. Press HOME to select the first node and END to select the end node.

Notes
· On a closed curve, the first and last nodes are the same.
· In an object with subpaths (which can be created using the Combine command), HOME selects the first node 

on the first object and END selects the last node on the last object.
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To select a single node or segment on a path

· Click the node or segment with the Shaper tool .

Notes
· Selected nodes becomes highlighted in one of two ways: hollow, if the associated segment is a line; solid, if 

the associated segment is a curve.
· If the node is on a curve, control points extend from the selected node and those on either side of it.
· Once you select a node or segment, you can move it and its associated control points.
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To select multiple nodes

1. Click the Shaper tool .
2. Hold down SHIFT and click the nodes you want to select.

Note
· You can also drag a marquee box around the nodes to select them.

{button ,AL(`Change the shape of freehand graphic objects;',0,"Defaultoverview",)} Related Topics



To deselect one or more nodes

1. Click the Shaper tool .
2. Hold down SHIFT and click the nodes you want to deselect.

Notes
· You can also hold down SHIFT and drag a marquee box around the nodes you want to deselect. This method 

also selects any nodes inside the marquee box that were not selected.
· To deselect all of the nodes, click any white space away from the outline of the curve.
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To shape a freehand graphic object by moving its segments

1. Select the curve object with the Shaper tool .
2. Drag the segment to achieve the desired shape.

Note
· You cannot move line segments using this method.
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To shape a freehand graphic object by moving its nodes

1. Select the curve object with the Shaper tool .
2. Drag a node to achieve the desired shape.

Note
· As you drag, the segments on either side of the node move. If the node is on a curved segment, the control 

points also move so that the angles at which the curve enters and leaves the node remain unchanged.

 Tip
· Double-clicking any graphic object with the Pick tool activates the Shaper tool and allows you to begin node 

editing.
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To shape a freehand graphic object by moving several nodes at once

1. Select the curve object with the Shaper tool .
2. Hold down SHIFT and click the nodes you want to select.
3. Drag any of the selected nodes to achieve the desired shape.

 Tip
· Double-clicking any graphic object with the Pick tool activates the Shaper tool and allows you to begin node 

editing.
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To shape a freehand graphic object by moving its control points

1. Select the curve object with the Shaper tool .
2. Click the node you want to manipulate.
3. Drag its control points to achieve the desired shape.

Note
· When the node is on a curved segment, the control points only extend from the selected node and those on 

either side of it.

 Tip
· Double-clicking any graphic object with the Pick tool activates the Shaper tool and allows you to begin node 

editing.
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To constrain the movement of a node or control point

1. Select the node or control point with the Shaper tool .
2. Hold down CTRL while dragging to force the node or control point to move horizontally or vertically from its
starting point.

 Tip
· Double-clicking any graphic object with the Pick tool activates the Shaper tool and allows you to begin node 

editing.
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To add nodes to a freehand graphic object

1. Click the Pick tool .
2. Double-click the line segment.
3. Right-click the line where you wish to add a node and click Add Node from the menu.
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To delete a node or segment from a freehand graphic object

1. Select the curve object with the Shaper tool .
2. Click the node you want to delete.
3. Press the DELETE key.

Note
· The position of the deleted node determines the change in the curve's shape.

 Tips
· Deleting closely bunched nodes and segments helps to simplify complex curve objects. You can also delete 

them to smooth unwanted bumps along a curve. 
· You can delete several nodes at once by selecting multiple nodes.
· Double-clicking any graphic object with the Pick tool activates the Shaper tool and allows you to begin node 

editing.
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To join two nodes on a freehand graphic object

1. Click the Pick tool .
2. Double-click the freehand graphic object.
3. Hold down SHIFT and click two nodes on the freehand graphic object.
4. Right-click and click Join from the menu.

Note
· You can’t join two adjacent nodes.
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Change the order of objects



To send to front

1. Click the Pick tool 
2. Click the object.
3. Click Arrange, To Front.

Shortcut
· SHIFT + PAGE UP moves an object to the front.
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To send to back

1. Click the Pick tool 
2. Click the object.
3. Click Arrange, To Back.

Shortcut
· SHIFT + PAGE DOWN moves an object to the back.
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To move forward one level

1. Click the Pick tool 
2. Click the object.
3. Click Arrange, Forward One.

Shortcut
· CTRL + PAGE UP moves an object forward one level.

{button ,AL(`Change the order of objects;',0,"Defaultoverview",)} Related Topics



To move back one level

1. Click the Pick tool 
2. Click the object.
2. Click Arrange, Back One.

Shortcut
· CTRL + PAGE DOWN moves an object back one level.
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Align and distribute objects



To align objects

1. Click the Pick tool .
2. Hold down SHIFT and click the objects you want to align.
3. Click Arrange, Align And Distribute.
4. Click a horizontal alignment button or a vertical alignment button, or one of each.

For example, if you want the objects aligned along their right edges, click only the Right Align button

.
5. Enable the Align/Distribute To Page button to align the objects in relation to the page, or the Align/Distribute To

Selection button to align the objects in relation to each other.
For example, if you want the objects aligned to the center of the page, and to be centered one on top of the 

other, click both Center Align buttons (  and 

), and enable the Align/Distribute To Page button. If you don't enable the button, the objects will be 
centered on top of one another, but not in the center of the page.
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To distribute objects

1. Click the Pick tool .
2. Hold down SHIFT and click the objects you want to distribute.
3. Click Arrange, Align And Distribute.
4. Click the Distribute Horizontally button or the Distribute Vertically button, or click both.
5. Enable the Align/Distribute To Page button to distribute the objects over the page, or the Align/Distribute To
Selection button to distribute the objects over the area the objects occupy.

For example, if you want the objects distributed over the entire page, enable the Align/Distribute To Page 
button. If you don't enable the button, the objects will be distributed over the area that they currently occupy.
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To center objects

1. Click the Pick tool .
2. Hold down SHIFT and click the objects you want to center.
3. Click Arrange, Align And Distribute.

4. Click either Center Align buttons (  or 

), or click both.
5. If you want the objects centered on the page, enable the Align/Distribute To Page button.

If you don't enable the Align/Distribute To Page button, the objects will be centered over each other, but not 
centered on the page.
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Scan images



To scan images into Corel Print House
1. Click File, Acquire Image, Acquire.
2. When the scanner dialog box opens, follow the directions that came with your scanner to set up and complete 

the scan.

Note
· You must select a scanning source the first time you use your scanner with Corel Print House, or when you 

want to change the scanner driver you are using.
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To choose a scanning source
1. Click File, Acquire Image, Select Source.
2. Choose a scanner driver from the Sources list box.
3. Click the Select button.
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To apply Gamut CD color correction to an image
1. Open the Photo CD Image.

The Photo CD Image dialog box automatically opens prior to displaying the image.
2. On the Enhancement tab, enable the Gamut CD button.
3. Enable a preview button on the right side of the dialog box. Best Preview displays an accurate color preview 

but requires more processing time. Fast Preview displays a quick preview of the image.
4. Enable the Set Active Area button and marquee select the area on the preview image that you want to be 

considered for the image enhancement calculations.
5. If there is white in the image, enable the Adjust White In Image check box and type a value in the Absolute 

White box to indicate how pure the whitest white should be (255 is pure white).
6. If there is black in the image, enable the Adjust Black In Image check box and type a value in the Absolute 

Black box to indicate how pure the blackest black should be (0 is pure black).
7. If there are neutral areas (black, gray, or white) in the image, enable the Set Neutral Colors button and click 

the neutral colors on the preview image. The color casts will be removed from the image. To obtain the best 
results, specify colors that span as much of the lightness range of the image as possible.

8. Click the Preview button to evaluate your settings.
9. Click OK to apply the color correction and display the image.

Notes
· Gamut CD uses gamut mapping to enhance the color fidelity and tonal ranges of the CD image. Gamut 

mapping ensures that colors in a computer image are reproducible by a printer.
· If the Suppress Filter Dialog check box is enabled in the Import dialog box, the Photo CD Image dialog box will 

not open. The image opens using the previous settings.

 Tips
· Disable the Adjust White In Image check box or Adjust Black In Image check box if your image does not 

contain one of these elements. Otherwise, the resulting image may either be too dark or too bright.
· To darken an image containing no black, enable the Adjust Black In Image check box and type a value greater 

than 0 in the Absolute Black box.
· To lighten an image containing no white, enable the Adjust White In Image check box and type a value less 

than 255 in the Absolute White box.
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To apply Kodak color correction to an image
1. Open the Photo CD Image.

The Photo CD Image dialog box automatically opens prior to displaying the image.
2. On the Enhancement tab, enable the Kodak Color Correction button.
3. Adjust the tint by typing values in the Red Tint, Green Tint, and Blue Tint boxes.
4. Adjust the brightness level by typing a value in the Brightness box.
5. Adjust the degree of saturation by typing a value in the Saturation box.
6. In the Color Metric list box, choose No Gamma Adjustment or a Contrast Level, as appropriate.
7. Enable the Show Colors Out Of Screen Gamut check box and click the Preview button to verify that the 

adjustments made in steps 3 to 6 are not too extreme.
If they are, out-of-gamut pixels will be rendered as pure red or pure blue so that you can identify out-of-gamut 
areas of the image and correct your adjustments.

8. Click OK to apply the color corrections and display the image.

Notes
· The Scene Balance Adjustment is made by the photofinisher at the time the original image is scanned and 

placed on the Photo CD disk. Enable the option to preserve the adjustments.
· If the Suppress Filter Dialog check box is enabled in the Import dialog box, the Photo CD Image dialog box will 

not open. The image opens using the previous settings.

 Tip
· Click Preview at any time to see the results of the settings on the image. The preview image is not 

continuously updated as settings are chosen.
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Print your work



To print your work
1. Click File, Print.
2. Do any of the following:
· Choose a printer from the Name box.
· Type a value in the Number Of Copies box.
· Click Properties to change the printer settings.

Notes

· If you are unsure of which options to choose, click the Key button  in the bottom right corner of 
the Print Dialog box to launch the Printing wizard.
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To print multiple copies
1. Click File, Print.
2. Type the number of copies in the Number Of Copies box.

 Tip

· For printing instructions, click the Key button  to start the Print wizard.
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To print double-sided projects
1. Click File, Print.
2. Do any of the following:
· Choose a printer from the Name box.
· Type a value in the Number Of Copies box.
· Click Properties to change the printer settings.
3. Click Print.

The Manual Double-Sided Printing wizard is automatically launched if your project is double-sided.
4. Follow the instructions in the wizard.

If you want to print your project on two sheets of paper, click Cancel when the wizard appears.

Note
· If you don’t want the Manual Double-Sided Printing wizard to print instruction sheets each time you print a 

double-sided project, you can disable the option in the Options dialog box.
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To disable double-sided printing instruction sheets
1. Click Tools, Options.
2. Click the General tab.
3. Disable the Print Instruction Sheets For Manual Duplexing Print Jobs check box.

An empty check box means the option is disabled.
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To print as many on a page as possible
1. Click File, Print.
2. Enable the Multiples On Page button.

 Tip

· For printing instructions, click the Key button  to start the Print wizard.

Note
· The Multiples On Page option calculates the best way to print as many copies of a project as it can on the 

page. The calculations may not conform to existing label sheets manufactured by some companies. For best 
results when printing custom labels, use full size 8.5" x 11" label pages rather than pre-scored labels.
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To print in color
1. Click File, Print.
2. Enable the Color button.

 Tip

· For printing instructions, click the Key button  to start the Print wizard.
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To print in grayscale
1. Click File, Print.
2. Enable the Grayscale button.

 Tip

· For printing instructions, click the Key button  to start the Print wizard.
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To print in coloring book style
1. Click File, Print.
2. Enable the Coloring Book button.

 Tip

· For printing instructions, click the Key button  to start the Print wizard.
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To print complex graphics
If you’re having trouble printing complex graphics, it could be a problem with the printer's Transmission Retry 
setting.

To adjust the printer's Transmission Retry setting in Windows 95 and NT 4.0
1. In Windows, click Start, Settings, Printers.
2. Click the printer you are using.
3. Click File, Properties.
4. Click the Details tab.
5. Increase the Transmission Retry setting from 45 seconds to 999 seconds.

To adjust the printer's Transmission Retry setting in Windows NT 3.51
1. In Windows, double-click the Print Manager folder.
2. Click the printer you are using.
3. Click Printer, Properties,
4. Click the Settings button.
5. Increase the Transmission Retry from 45 seconds to 999 seconds.

Note
· You will not be able to adjust the Transmission Retry settings of Network printers using these methods.
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To print envelopes
If you’re having trouble printing envelopes, it could be a problem with the printer's properties settings. Some 

printers do not allow you to adjust these settings directly from Corel Print House  you must adjust 
them directly from the Windows 95 Printers folder.

To adjust printer Properties
1. In Windows 95 and NT 4.0, click Start, Settings, Printers.

In Windows NT 3.51, double-click the Print Manager folder.
2. Click the printer you are using.
3. In Windows 95 and NT 4.0, click File, Properties.

In Windows NT 3.51, click Printer, Properties,
Depending on your printer, you may need to click the Paper tab.

4. Check and adjust the following as necessary:
· In the Paper Size box, ensure you have the correct envelope size selected.
· In Orientation, ensure the correct button is enabled. The most common orientation for printing envelopes is 

Landscape. Consult your printer’s manual for the correct orientation for your printer.
· In the Paper Source list box, ensure you have the correct tray for envelopes selected. If your printer has an 

envelope feeder, ensure it is selected.

Note
· Consult your printer’s manual to ensure you are feeding the envelope into the printer correctly. Some printers 

require envelopes to be in the middle of the paper feeder, and others require the envelope to be aligned with 
the side of the paper feeder.
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To change printers
1. Click File, Print.
2. Choose a printer from the Name List box.

If the printer you need is not listed, install it following the usual Windows procedure.

 Tip

· For printing instructions, click the Key button  to start the Print wizard.
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To set paper size
1. Click File, Print.
2. Click the Properties button.
3. Choose the paper size from the Paper Size box.

 Tip

· For printing instructions, click the Key button  to start the Print wizard.
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To set paper orientation
1. Click File, Print.
2. Click the Properties button.
3. Enable an Orientation button.

Note
· The orientation you choose when you print should match the orientation of the artwork.

 Tip

· For printing instructions, click the Key button  to start the Print wizard.
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To fit your drawing to a single page
1. Click File, Print.
2. Enable the Fit To Page button.

Note
· Fit To Page shrinks or expands your artwork to fit on one piece of paper.

 Tip

· For printing instructions, click the Key button  to start the Print wizard.
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To use PaperDirect paper
1. Click File, Print.
2. Enable the Use PaperDirect Paper check box.

Note
· If you print a PaperDirect project without choosing PaperDirect paper, the guidelines that appear on screen are

printed with your project. To remove the guidelines, use the Merge Backdrop command on the Tools menu, and
then select the lines with the Pick tool and delete them. You may need to use the Ungroup command on the 
Arrange menu to ungroup the backdrop after merging it.

 Tip

· For printing instructions, click the Key button  to start the Print wizard.
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To merge a Namelist with your project when printing
1. Click File, Print.
2. Enable the Use Namelist check box.

When you click OK, the Namelist wizard opens.
3. Click the Namelist you want to use.
4. Click the records you want to use.

Note
· You must add Namelist fields to your project to use this option.
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Fold your cards and brochures



To fold a half-fold card
· Fold the paper in half along its width.
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To fold a top quarter-fold greeting card or notecard
1. Fold the paper in half lengthwise.
2. Fold it in half again.

Note
· You can see video demonstrations for folding quarter-fold cards by clicking Folding Demonstrations in the Help 

menu.
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To fold a side quarter-fold card
1. Fold the paper in half.
2. Fold it in half again.

Note
· You can see video demonstrations for folding quarter-fold cards by clicking Folding Demonstrations in the Help 

menu.
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To fold a three-panel brochure or menu in the Z pattern
1. Mark the paper into three sections of equal width.
2. Fold the last section to cover the second section.
3. Fold the back of the first section to cover the back of the second section.

Note
· You can see video demonstrations for folding three-panel brochures by clicking Folding Demonstrations in the 

Help menu.
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To fold a three-panel brochure or menu in the regular pattern
1. Mark the paper into three sections of equal width.
2. Fold the last section to cover the second section.
3. Fold the first section to cover the second section.

Note
· You can see video demonstrations for folding three-panel brochures by clicking Folding Demonstrations in the 

Help menu.
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To fold a cut and fold envelope
1. Cut the envelope out of the sheet of paper along the outer lines.
2. Fold the small side flaps inward along the line (see red arrows below).
3. Fold the bottom flap inward along the line (see blue arrows below).
4. Glue or tape the bottom flap to the small side flaps.
5. Place the card or paper you are sending in the envelope.
6. Fold the top flap inward along the line (see black arrow below).
7. Seal the envelope.
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Change Corel Print House settings



To change the default settings
· Click Tools, Options.

Note
· The Options dialog box allows you to change the default page size, units of measure, Notebook colors, Create 

wizard and Calendar wizard settings, undo levels, duplicate placement settings, object movement settings, 
and line drawing settings.
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To install additional fonts from the Corel Print & Photo House CD-ROM
1. Insert the Corel Print & Photo House CD-ROM in your CD-ROM drive.
1. In Windows, Click Start, Settings, Control Panel.
2. Double-click the Fonts folder.
3. Click File, Install New Font.
4. Choose your CD-ROM drive in the Drives list box.
5. Double-click the Fonts folder.
6. Double-click the TTF folder.
7. Click the font(s) you want to install in the List Of Fonts box,.

To select multiple fonts, hold down the CTRL or SHIFT keys before clicking the font names.
8. Click OK.
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To display the Standard toolbar
· Click View, Standard Toolbar.

Note
· When the Standard toolbar is displayed a check mark appears beside the Standard Toolbar command. To hide 

the toolbar click View, Standard Toolbar.
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To display the Text toolbar
· Click View, Text Toolbar.

Note
· When the Text toolbar is displayed a check mark appears beside the Text Toolbar command. To hide the toolbar

click View, Text Toolbar.
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To change the desktop colors
1. Click Tools, Options.
2. Click the Desktop Colors button.
3. Click the Notebook Background or Desktop Background button.
4. Click a color from the color palette.

Use the scroll bars to access additional colors, or click the More button to access the HSB and RGB color 
models.

Note
· To reset the desktop to its original colors, click the Reset button.

 Tip
· You can also change the desktop colors by right-clicking on any area of the desktop and choosing Page Colors
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To choose the first day of the week for the Calendar wizard
1. Click Tools, Options.
2. Click the General tab.
3. If you want to use Sunday as the first day of the week, disable the Monday first day of week checkbox.

If the checkbox is enabled, Monday is used as the first day of the week.

Note
· This setting affects the Calendar wizard only.
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